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U.S. Export Administration Act: Restrictions on Exporting
Software

The Software includes cryptographic software that may be subject to export controls
under the U.S. Export Administration Act. The Software may not be exported to any
country or to any foreign entity or “foreign person” to the extent prohibited under
applicable U.S. government regulations. By downloading or using the Software, you
are acknowledging and agreeing to the foregoing limitations on your right to export or
re-export the Software, and are also representing and warranting that you are neither
on any of the U.S. government's lists of export precluded parties nor otherwise
ineligible to receive software containing cryptography that is subject to export controls
under the U.S. Export Administration Act.

Administrators must be aware that allowing users outside the United States to access
data via certain DI-Clients qualifies as exporting encryption software (either the client
executable or the Java applet sent to the browser). Export or re-export of encrypted
software must be in accordance with the Export Administration Regulations. Diversion
of encryption software contrary to U.S. law is prohibited.

More Information

More information about trademarks, product warranty, and third-party license notices
is available in your DI software Help system. At the bottom of any Help page, click
Product Information, and then click Disclaimers, Trademarks, Warranty, and
Third-Party Licenses.
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Diver Platform 7.1

Diver Platform 7.1 Overview

About This Installation Guide

This guide contains installation, configuration, and verification procedures to
install the Diver Platform Server 7.1 package for Linux and Diver Platform
Developer 7.1 package for Windows. The server package contains Diveline and
web clients DivePort, NetDiver, Bridge, and DIAL; the developer package
contains the desktop clients Workbench, ProDiver, and Help Desk. All
Dimensional Insight products in these packages are listed as follows:

Diver Platform—The Dimensional Insight software suite that contains
Diver 7.1 software, including Workbench and Spectre. User categories are:
Developer, ProDiver, DivePort, and DiveTab.

Diver Solution—The Dimensional Insight software suite that contains
Diver 7.1 software, including Workbench. User types are tiered: Developer,
Advanced, General, and Casual.

DiveLine—The server component of the Diver Platform and Diver
Solution. DivelLine authenticates users and controls access to data through
Diver clients such as Workbench, ProDiver, DivePort, and DiveTab.

Spectre—The data analysis software in the Diver Platform. Spectre
processes data from a database or file to build a column-oriented
database (cBase) that caches efficiently on both the server and client
device. Spectre is integrated with DivelLine.

Workbench—An integrated development environment to develop, test,
and manage projects associated with a Diver application.

ProDiver—The desktop analytics client of the Diver Platform and Diver
Solution.

NetDiver—The zero-footprint web-based analytics client that provides ad
hoc reporting.

DivePort—The client used to build and display portals that present your
Diver data and any other content you need to share over the web.

Help Desk—A desktop component that provides access to user
maintenance for the DI client-server applications on the Diveline server.

DiveTab—The client that provides mobile users access to unstructured
content and structured data. It uses guided data navigation and one-
touch access on an iPad, PC, or phone. DiveTab is distributed separately.
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» Bridge—A web application based on DivePort technology that you can
use to navigate your DI applications from one central place.

NOTE: You need to be an administrative user to install the software.

If you run into any issues during the installation, contact DI Customer Support
for assistance:

* North America: 920-436-8299 or support@dimins.com

» United States: https://www.dimins.com/dimensional-insight-support/
e China: +86 20-8129-6052

e Germany: +49 711490 04-218

e Netherlands: +31 (0) 88-514 88 00

e Qutside of the United States: https://www.dimins.com/international/

About Roles and Environments

DI suggests that there are four basic roles to consider in a customer installation
and deployment. The roles are:

1. Development—People responsible for the creation of cBases, cPlans,
Dive files, classic models, DivePlans and markers, and pages for DivePort
or DiveTab

2. Test—People responsible for change control and data validation when
rolling out a new application, or upgrading software

3. Production—People responsible for delivering data to users through any
of the DI clients

4. Build—People responsible for the part of the extract, transform, and load
(ETL) process involving the creation of up-to-date cBase and model files
on a regular, usually nightly, schedule

Roles are independent of machines or engines and more than one role can be
performed in the same environment. For example, if the people responsible for
content development are also responsible for testing and validation, you can
combine the Development and Test roles in the same environment. However,
Test and Development environments should be isolated from the Production
environment to prevent untested content from reaching users.

DI supports and recommends the use of virtual machines to manage resources.
A best practice is to host virtual machines on hardware dedicated to DI
applications.

DI recommends that the Production, Development, and Test environments
reside on separate machines, either physical or virtual, and host one Diveline
service for each role.

Diver Platform 7.1 Overview
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About Installing DI Software on a Linux Platform
There are many flavors of Linux and many ways to install the DI software.

This guide provides general instructions, guidelines, and examples about how to
install the Diver Platform 7.1 Server software for Linux on a Virtual Machine (VM)
using the following versions of VMware and Ubuntu:

¢ VMware version 10.0.3
e Ubuntu version 16.04

NOTE: Check the versions of Java and Apache Tomcat that your Linux machine
supports before installation.

The Diver Platform Server package contains DivelLine and the DivePort and
NetDiver web clients.

» DiveLine — The server component of the Diver Platform and Diver
Solution. DivelLine authenticates users and controls access to data through
Diver clients such as Workbench, ProDiver, DivePort and DiveTab.

» DivePort — The client used to build and display portals that present your
Diver data and any other content you need to share over the web

* NetDiver — The zero-footprint web-based analytics client of the Diver
Platform. NetDiver provides ad hoc reporting and analytics tools in a web
browser. NetDiver requires a connection to the DivelLine server software to
access data.

It is important to note that the licenses for using DI software reside on the
server. In a Linux environment, you can install Diver Platform Server 7.1 software
on a Linux server while all Windows-based clients install on Windows laptops.
To install DI Windows clients, such as ProDiver and Workbench, see Installing
Diver Platform Developer on page 79.

When using this guide, command line commands are formatted as follows:
This is a command that is typed into the Linux command
line.

This guide assumes that a Linux administrator has access to perform the
following pre-installation actions:

 Build the DI directory structure and download the third-party and DI
software to the DI downloads directory.

» Set the permissions on the DI directories. (The instructions in this guide
identify where you might need to update the permissions on a directory or
file.)

In the course of installing DI software, the following permissions might need to
be added to files or directories:

Diver Platform 7.1 Overview
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Character Permission

r Read permission to open and read a file or to list the contents of
a directory.
w Write permission to modify the contents of a file or to change

the contents of a directory.

X Execute permission to run an executable file or to navigate a

directory with the cd command.
N J

NOTES:
* Installing the DI Platform Server for Linux is a manual process; Linux

installation does not use a wizard such as is available with the Windows
installation.

» When installing to a virtual machine, it is a best practice to use a fixed
Media Access Control (MAC) address. This prevents licenses issues if the
VM is relocated.

About Diver Platform Server 7.1

DI recommends that you isolate installation environments by role. Each role,
such as Development, Test, and Production, should have its own server
environment to ensure optimal data processing. You can install multiple server
environments on computers with VM capabilities. In some cases, several roles
can share a single server environment by assigning different DivelLine port
numbers to each role.

The following table shows common mid-range deployment environments and
the Divelines that they typically connect to on a physical or virtual machine.
Each installed DiveLine requires its own port number and license. You must
perform a complete Diver Platform Server installation for each Diveline.

Environment Port Number

Production 2130

Test 2131 J

Diver Platform 7.1 Overview
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Environment Port Number

Development | 2132
Build 2135
Bridge 3330
N J

Diver Platform 7.1

The following table shows common low-range deployment environments and
the Divelines that they typically connect to on a physical or virtual machine.

Environment

Port Number

Production

2130

LDeveIopment/Test

2131 J

The following illustration provides an overview of the DI server infrastructure
that is installed with the Diver Platform Server package. It highlights the primary
clients and how the Diveline servers are installed on a virtual server machine.
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NOTE: When using Unicode for one component, make sure all components are
Unicode. For example, you must have a Unicode Diveline server to serve
Unicode encoded content to a Unicode client.

About Diver Platform Developer 7.1

The Diver Platform Developer 7.1 package includes the following executable
files:

» di-broadcast.exe—A Diveline client that delivers data to selected users
through email. Deliveries can be scheduled on an episodic or periodic
basis, or triggered by a specific event.

« di-config.exe—A Diveline subcomponent that allows an administrator to
configure Diveline options by using a Windows user interface. Included to
ease transition from version 6.x to 7.1. In 7.1, DI-Config functionality is part
of the Workbench Server Settings.

 di-scheduler.exe—A Diveline subcomponent that allows administrators
to schedule jobs by using a Windows user interface. Included to ease
transition from version 6.x to 7.1. DI-Scheduler functionality is integrated
into Workbench.

» HelpDesk-Setup.exe—Installation software for the desktop component
of the Diver Platform. Help Desk provides access to user maintenance for
client-server applications on Diveline. It requires a separate license.

» ProDiver-Setup.exe—Installation software for the desktop analytics
client of the Diver Platform. ProDiver is the client in a client-server
architecture, which means it requires a connection to a Diveline server to
access data.

» Workbench-Setup.exe—Installation software for the integrated visual
development environment to develop, test, and manage projects
associated with Diver Platform software.

The Diver Platform Developer package contains the Workbench and ProDiver
clients that are required to build a DI data infrastructure. You install the
developer software on computers independent of any other computers or
machines that contain the server software. The developer software typically
resides on computers intended for the system administrator or DI content
developers.

The following illustration shows some of the components of Workbench and
ProDiver that are installed with the DI Platform Developer package. You can see
that all of the client applications in this package are installed on user computers
connected to the application server behind the company firewall.

Diver Platform 7.1 Overview
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Diver Platform Developer Installation Application
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Software Requirements

Before you install and operate Diver Platform 7.1 software, ensure that the
following application server, web server, and desktop client requirements are
met. In general, DI recommends that you use the latest versions.

TIP: Check the DI website periodically for new Security Notices.
NOTE: A 64-bit operating system is required for servers.

Application and
Web Server

Support Notes

Linux Fully supported in the following configurations: Red
Hat Enterprise Linux, CentOS, Debian, Ubuntu, SuSE.

Latest version is recommended. 64-bit is required.

The Mono component is required to run Diver Platform
and Diver Solution on Linux systems.

DI recommends that you download the latest release
from http://www.mono-project.com/download/.

The libodbc.so.1 library does not ship with the installer.
It must be installed separately.

Microsoft Windows | Minimum version for 7.1. Fully supported.

For more information about memory limits of specific

L versions, please refer to Microsoft's guidelines. )

Server 2016 or later

Diver Platform 7.1 Overview
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Desktop Operating

Support Notes
System

Microsoft Windows 10 | Fully supported. Recommended version.

Microsoft Windows Fully supported.
8.1

Microsoft Windows 8 | Fully supported.

Microsoft Windows 7 | Browser compatibility issues might impact web
clients.

IMPORTANT: Windows 7 does not support TLS 1.2 in
its default configuration, which Diveline 7.1 requires
to communicate with Workbench. For more
information, see Technical Notice 9 on DI's customer
website.

NOTE: Controls for HTTP cookies and JavaScript must be enabled for each client
computer's web browser.

Web Browser Support Notes

Internet Explorer 11 or Fully supported. Some dashboard features might

not run in versions 10 and earlier.
later

Google Chrome, Microsoft | Fully supported. Latest version recommended.

Edge, Mozilla Firefox,

Safari
N Y,

NOTE: The following third-party software comes bundled with the Dl installers
for Windows.

Diver Platform 7.1 Overview
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Support Notes

OpenJDK 11 Latest version is recommended.
Java 10 Minimum version required. Some features might not
function.

IMPORTANT: Due to Java licensing changes, updates for Oracle's Java Runtime
Environment are no longer available for business, commercial, or production
use without a commercial license. DI recommends using OpenJDK.

Apache Tomcat Support Notes

Tomcat 9.0 Latest version is recommended.

Tomcat 8.5.0 Minimum version required for for 7.1. On Tomcat 8
and later, make sure to remove the unpackWaARr
attribute from the context tag in DivePort's context
xml file. The unpackwAR attribute is removed for
Tomcat 8 and later by using the Dimensional Insight

installers.

Tomcat 7.0 Tomcat 7.0 reached it's end-of-life as of March 2021,

and no longer receives updates. DI recommends

updating to Tomcat 9.0.

Microsoft Support Notes

.NET Framework 4.7.2 | The .NET Framework helps you create mobile,
or later desktop, and web applications that run on Windows

PCs, devices, and servers.

Diver Platform 7.1 Overview
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NOTE: When installing to a VM, DI recommends that you use a fixed Media
Access Control (MAC) address. This prevents licenses issues if the VM is
relocated. See the VMware Knowledge Base at http://kb.vmware.com.

About the DI Directory Structure

Prior to downloading and installing DI Platform server and developer software
for 7.1, Dl recommends that you create the following directory structure on your
machine:

/di

/projects

/platform
/downloads
/licenses
/webapps
/webdata

NOTE: Make sure the directory structure is created from the root directory.

If yours is a large site where content is developed, tested, released, and
extracted in four separate phases, but the content is stored on a single server,
consider using a four-stage release process with a slightly different DI directory
structure.

Stage 1: Development | | Stage 2: Testing | | Stage 3: Production | | Stage 4: Build
/di /di /di /di
Jdew Jaga flive Jetl

/projects /projects
/platform /platform

/projects /projects
/platform /platform

/downloads /downloads
/licenses /licenses
/webapps /webapps
/webdata /webdata

/downloads /downloads
/licenses /licenses
/webapps /webapps
/webdata /webdata

NOTE: This reflects the environments used on a single server so the di directory
has subdirectories for each environment.

You can install server and developer software on a single machine or different
machines using the same directory structure.

The following table provides a brief description of the default directories and
subdirectories in a typical DI directory structure.

Diver Platform 7.1 Overview
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Directory

Subdirectory

Diver Platform 7.1

Description

/di

/projects

Default location for Workbench
projects. This directory is created

manually.

/di

/platform

Default location for directories and files
created by DI product installations. This

directory is created manually.

/di/platform

/downloads

Default location for DI software
downloads. This directory is created

manually.

/di/platform

/licenses

Directory for licenses and key files. This

directory is created manually.

/di/platform

/diveline

Subdirectory with program files
required by the Diveline service. Each
installed DivelLine instance can have its

own /diveline directory.

/di/platform

/dl-dataroot

Top level directory for the Diveline
server for configuration information,
cache, and log files. Each installed
DivelLine instance can have its own /d1-

dataroot directory.

/di/platform

/executables

Default location for many DI executable

files.

Diver Platform 7.1 Overview
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p
/di/platform | /webapps Program, configuration, and setup files
for DivePort and NetDiver. This
directory is created manually.
/di/platform | /webdata Data and customization files for
DivePort and NetDiver. This directory is
created manually.
-

Building the DI Directory Structure

NOTE: You must have root user privileges (for example, enter sudo bash) to
build out the DI directory structure from the root directory. Do not build the DI
structure from the home directory.

This procedure creates the basic structure for Diver Platform Server Linux
installation.

Complete the following steps:
1. Log in to your Linux machine.
2. Open a command line.

jsmith@ubuntu: ~

s administrator (user "root"), use "sudo <command>".
" for details.

jsmith@ubuntu:~$ I

3. Go to the root directory.
cd /
4. Create the di directory.
sudo mkdir di
NOTE: Enter the user password if prompted.
5. Confirm that the di directory was created successfully:
1ls

A list of files and directories in the root directory displays.

Diver Platform 7.1 Overview
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jsmith@ubuntu: /S sudo mkdir di
[sude] password for jsmith:
jsmith@ubuntu:/$ 1s

bin dev home lib64 mnt root vmlinuz
boot di initrd.img Tlost+found opt run v usr
cdrom etc 1ib media proc sbin sys var

Change to the di directory:
cd di
Optionally, create a directory for each environment.
a. Create a directory (for example, 1ive).
sudo mkdir live
b. Confirm that the directory or directories were created successfully:
1ls
A list of files and directories in the di directory displays.

c. Navigate to the environment (for example, 1ive) before creating the
subdirectories:

cd live

NOTE: This guide does not use environments. Therefore, all subdirectories
are contained within the di directory.

Add the following subdirectories by typing each of the following
commands:

e sudo mkdir platform

e sudo mkdir projects
Confirm that the directories were created successfully:
1ls
A list of files and directories in the di directory displays.
Navigate to the platform directory:

cd platform

Add the following subdirectories by typing each of the following
commands:

e sudo mkdir downloads
e sudo mkdir licenses
® sudo mkdir webapps

® sudo mkdir webdata

Confirm that the directories were created successfully.

Diver Platform 7.1 Overview
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1s

A list of files and directories in the plat form directory displays.

About Diver Platform and Solution 7.1 Licenses

Diver Platform 7.1 is the paid upgrade path for customers who want to use the
Spectre engine, DiveTab, or Measure Factory. Diver Solution 7.1 is the free,
standard software upgrade path for Diver Solution 7.0 customers on a
maintenance plan. Users licenses differ depending on whether you use Diver
Platform or Diver Solution.

NOTE: Some features, such as Input Tables, Measure Factory, and Help Desk,
are licensed separately from your Diver Platform or Diver Solution license.
Contact your Dimensional Insight sales representative for more information.

Diver Platform Licenses

User categories are defined for Diver Platform licensing. To use different client
programs, a user can belong to multiple license categories. Each named user is
in zero or more user categories.

Each category has a limited number of users, based on the number of licenses. If
more users are assigned to the category than the license allows, excess users are
denied access. Users that do not authenticate successfully are denied access
and told to contact an administrator.

The user license types for Platform 7.1 are:
» Developer—Grants access to Workbench and all Diver clients
» ProDiver—Grants access to ProDiver, Broadcast, and DIAL
» DivePort—Grants access to DivePort and NetDiver
o DiveTab—Grants access to DiveTab for the iPad and PC

» Help Desk—Grants access to Help Desk and DI-Config to manage user
account changes without consuming a Developer license

o ODBC—Grants access to DI-ODBC driver

Diver Solution Licenses

Diver Solution 7.1 maintains the tiered user licensing scheme that is used in
Diver Solution 6.4, with the addition of a new tier called Developer. Different
tiers give users access to different client programs. Each named user is in one
tier only. If you assign more users to a tier than the license allows, the
administrator sees a warning, and the last user assigned is disabled.

The tiered user types for Solution 7.1 are:

Diver Platform 7.1 Overview
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Developer—Grants access to Workbench and all Diver clients

Advanced—Grants access to ProDiver, DivePort, NetDiver, DI-Config, DI-
Broadcast, DI-Scheduler, and DIAL

General—Grants access to DivePort, NetDiver, and DI-Config

e Casual—Grants access to DivePort

What Is Named User Licensing?

Diver Platform and Diver Solution use named user licensing. In this type of
licensing scheme, each user has their own unique login information and can be
logged in from only one computer at a time.

About License Types

Whether you use Diver Platform or Diver Solution, your product licenses fall into
one of two categories:

Perpetual Licenses

You use a perpetual license for software that you purchased on a maintenance
contract. This type of license allows you to have a certain number of users and
virtual environments based on the conditions in your maintenance contract and
provides for routine software updates.

Perpetual licenses become outdated on the same day that your maintenance
contract ends. When you renew your maintenance contract, you receive a new
license so that you can continue to receive software updates.

If you choose not to renew your maintenance contract, you can continue to run
the software using the outdated license. However, you cannot upgrade the
software or move it to a new machine.

Trial Licenses
You use a trial license for software that you are trying for a short period of time.

Trial licenses have an expiration date. Once the expiration date passes, you can
no longer run the software that the trial license enables.

NOTE: A license's expiration or maintenance date is always on the first of the
month. For example, a license with a maintenance date of 11/2021 becomes
outdated on November 1st, 2021.

Diver Platform 7.1 Overview
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Installing Diver Platform Server

Downloading the Server Installation Package

You can download purchased software from the Dimensional Insight website.
Dimensional Insight recommends that you download the software by using a
graphical web browser rather than by invoking the wget command. Depending
on your computer's internet access settings, you might need to use another
computer to download the server package, and then transfer the files to your
server.

NOTE: Administrative privileges are required to install the software.

1. Using a web browser, go to the Dimensional Insight website:
http://www.dimins.com.

2. On the home page, click Sign In.

%,920436-8299 & info@dimins.com Support English ~

thf‘?scinﬂa}. Home  What's New  Industries ~ YourRole ~ Technology ~ Partners ~ Resources ~ Company ~ 0O

The Customer & Distributor Login Area page opens.

3. Click DI Download / Customer Log In.

Customer & Distributor Login Area

Download Software, Release Notes, And Product Documentation

-
NOTE: Customers using IE8 and IES have reported issues reaching DI
DI Download / Customer LOg In @ ‘ Download via this web site. These customers should type in the url

address directly into the URL address bar where they will be
.. presented with a popup window and required to enter a username
and password: https:/Awww.dimins.com/customersite/. Also note
that you must NOT block pop ups!
Others may log in using the following 2 links. Contact Customer
Support to request a password to the following areas: DI
Download/Customer Log in, Distributor/Partner Log in.

Training ®
CUSTOMER SUPPORT

Hours: 7:00am to 5:00pm CST

Tel: 920-436-8299

Email: support@dimins.com

The Authentication Required dialog box opens.

Installing Diver Platform Server
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@) Authentication Required - Mozilla Firefox
& https://www.dimins.com is requesting your username
and password. The site says: “Dimensional Insight Secure
Site”
User Name: |
Password:

4. Enter your User Name and Password, and click OK.
The Dimensional Insight Customers home page opens.
5. Click DI-DOWNLOAD.

Welcome to the home page for

Dimensional Insight Customers

All software packages and release notes are available on DI-DOWNLOAD.
If you have any questions, contact our Customer Support Team at suppart@dimins.com.

DI-DOWNLOAD
Download the latest software updates and documentation.
>>DI-DOWNLOAD

The software and documents download page opens.

main web site  contact

Dimensional

I'NSITGHT X
download training consulting blog

[
Client: Dimensional Insight, Tech
- Info 6.4 6.4.1 (1166KB) Previous Point Releases Net Available Not Available
- Licensing 7.1 Update not available Mone Available Not Available Not Available
- Licensing 7.0 7.0.29 (23102KB) Previous Point Releases Not Available Not Available
- Licensing 6.4 6.4.25 (2817KB) Previous Point Releases Not Available Not Available -

6. Locate the latest version of the 7.1 software that you purchased, and click
the blue version number.

Diver Platform European Language Pack 7.0 Windows Unicode 7.0.50 (1046991KB) Previcus Point Releases Not Available Mot Available
Diver Platform European Language Pack 7.0 Windows 7.0.50 (1046784KB) Previous Point Releases Not Available Not Available
B\ver Platform Server 7.1 linux64_uc limited 7.1.4 (535373KB) Previous Point Releases Not Available Mot Available
Diver Platform Server 7.1 linux64 7.1.4 (525466K8B) Previous Point Releases Not Available Mot Available
P\ver Platform Server 7.1 linux64 limited 7.1.4 (525160KB) Previous Point Releases Not Available Mot Available
Diver Platform Server 7.1 Windows Unicode limited 7.1.4 (1946758KB) Previous Point Releases Not Available Mot Available
Diver Platform Server 7.1 Windows 7.1.4 (1927188KB) Previous Point Releases Not Available Mot Available

The Opening download verification dialog box opens.

Installing Diver Platform Server
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The Downloading page opens in the browser. If the Opening dialog box
does not open automatically, follow the instructions on the page:

Select Save File, and click OK.

The Diver Platform Server software package zip file downloads to the
Downloads directory on the local computer.

NOTE: Most browsers enable you to configure the download location for
files downloaded from the Internet. For example, if you are using the
Firefox browser on Linux, you can choose Edit > Preferences and
configure the download location.

If necessary, move the zip file to the Linux server.

On the Linux server, enter the following command to move the zip file to
the /di/platform/downloads directory:

sudo mv diver-platform-server-<version number>-
linux64.zip /di/platform/downloads

Extracting the Server Installation Package

1.

Go to the /di/platform/downloads directory by entering the following
command:

cd /di/platform/downloads

Confirm that the diver-platform-server-<version number>-linux64.zip file
is in this directory by entering the following command:

1ls

Copy the file to the /di/platform directory by entering the following
command:

sudo cp diver-platform-server-<version number>-
linux64.zip /di/platform

Navigate to the /di/platform directory by entering the following
command:

eal .-

Confirm that the file is in this directory by entering the following
command:

1ls

Unzip the diver-platform-server-<version number>-linux64.zip file by
entering the following command:

Installing Diver Platform Server

18



Diver Platform 7.1

sudo unzip diver-platform-server-<version number>-
linux64.zip

7. After the processes finishes, list the files in the directory by entering the
following command:

1ls
Verify that the following files display:
* di-diveline.tar.gz
» web-tools.zip
8. Extract the di-diveline.tar.gz file by entering the following command:
sudo tar -xvf di-diveline.tar.gz
9. Verify that the files are extracted by entering the following command:
1ls

The following new directories now display:
e diveline

e executables

Obtaining a License for the DI Software

You need to request and install a license, which enables you to run the software
that you purchased.

For this part of the installation, you must use a computer with a Windows
operating system that can access the Internet. If you do not have access, contact
Dimensional Insight Customer Support.

Using the exportinfo Utility to Obtain Machine Information

You use the exportinfo utility to export your machine's name, operating system,
and machine ID to a machine information (info) file. You need this information
to request a license.

1. On the Linux server, go to the /di/platform/executables directory by
entering the following command:

cd /di/platform/executables

2. Confirm that the exportinfo utility is in the directory by entering the
following command:

1s

The contents of the directory display, including the exportinfo file.
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. View the permissions for the exportinfo utility by entering the following

command:

1ls -1 exportinfo

The permissions display. If an x displays within the first group of letters
(for example, -rwxr--r--), you can run the utility.

If you do not have permission to run the utility:
a. Enable the execute permission.
sudo chmod a+x exportinfo
b. Verify that the permissions have changed.

ls -1 exportinfo

The permissions display as -rwxr-xr-x.

. Run the exportinfo utility by entering the following command:

sudo ./exportinfo

The exportinfo utility prompts you to specify a name for the machine
information (info) file.

. Specify a file name by doing one of the following:

» Accept the default file name—di_minfo_<your machine's name>.info
(for example, di_ minfo_ubuntu.info)—by pressing the Enter key.

e Enter a name for the file, including the info extension, and press the
Enter key. For example, di minfo jsmith-ubuntu.info.

You can use any file name that is meaningful to you, but it is a good
idea to identify your machine in the file name, so that you can
recognize it later.

. Confirm that the file was created successfully by entering the following

command:
1s

The contents of the directory display, including the info file that you
created.

. (Recommended) Move the machine information file to the

/di/platform/licenses folder by entering the following command:

sudo mv <file name>.info ../licenses

. Gotothe /1icenses folder and confirm that the file was moved

successfully by entering the following command:
1s

Installing Diver Platform Server
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9. Copy the info file onto a Windows computer that can access the Internet,
so that you can use it to request a license.

Obtaining the Licensing Package
1. On the Windows computer with the info file, open a web browser, and go
to the Dimensional Insight website www.dimins.com.

2. On the home page, click Sign In.

%,920436.8299 5 outreach@dimins.com Support English v

Dimensional, Home WhatsNew Industries v  YourRole v  Technology v  Resources v Company v 0

The Customer & Distributor Login Area page opens.

3. Click DI Download / Customer Log In.

Customer & Distributor Login Area

Download Software, Release Notes, And Product Documentation

NOTE: Customers using IE8 and IES have reported issues reaching DI
DI Download / Customer LDg In @ ] Download via this web site. These customers should type in the url
address directly into the URL address bar where they will be

presented with a popup window and required to enter a username

Distributor / Partner LOg In @ and password: https://www.dimins.com/customersite/. Also note

that you must NOT block pop ups!

Documentation @ Others may log in using the following 2 links. Contact Customer
Support to request a password to the following areas: DI
Download/Customer Log in, Distributor/Partner Log in.

Training ®
CUSTOMER SUPPORT

Hours: 7:00am to 5:00pm CST
Tel: 920-436-8299

Email: support@dimins.com

A dialog box prompting for your sign-in information opens.

B www.dimins.com
This site is asking you to sign in.
Username
Password
Can(el
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4. Enter your Username and Password, and click OK.
The Dimensional Insight Customers home page opens.
5. Click DI-DOWNLOAD.

Welcome to the home page for

Dimensional Insight Customers

All software packages and release notes are available on DI-DOWNLOAD.
If you have any questions, contact our Customer Support Team at support@dimins.com.

DI-DOWNLOAD
Download the latest software updates and documentation.
>>DI-DOWNLOAD

The software and documents download page opens.

main website  contact

Dimensional

I'NSITGHT
download training consulting blog

Client: Dimensional Insight, Tech

- Info 6.4 6.4.1 (1166KB) Previous Point Releases Net Available Not Available
- Licensing 7.1 Update not available Mone Available Not Available Not Available
- Licensing 7.0 7.0.29 (23102KB) Previous Point Releases Not Available Not Available
- Licensing 6.4 6.4.25 (2817KB) Prewvious Point Releases Net Available Not Available

6. Locate the latest version of the Licensing 7.0 package, and click the blue
version number.

- Info 6.4 6.4.1 (1166KB)

- Licensing 7.0 ?.O.Zﬁ(ZBIDZKB)J
- Licensing 6.4 6.4.25 (2817KB)

- Trial Licenses 6.1 6.1.1310 (25KB)

The Downloading page opens in the browser. If the Opening
confirmation box does not open automatically, follow the instructions on
the page:
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Downloading: - Licensing 7.0.29

If the download fails, click here.
Please tell us what you were trying to download and which web browser you were using (including version).

To return to your downloads list, click your browser's ‘Back’ button.

7. On the Opening licensing confirmation box, select Save File, and click OK.

Opening licensing-7.0.29-pkg.zip x

You have chosen to open:
D licensing-7.0.29-pkg.zip
which is: WinZip File
from: https://www.dimins.com
‘What should Firefox do with this file?
(O Openwith | WinZip (default) ~
(@) Save File

[ pe this gutomatically for files like this from now on.

Cancel

The licensing software package zip file is downloaded to the Downloads
directory on the local computer.

NOTE: The Licensing 7.0 package includes one file, called licensing-
<version number>-pkg.zip (for example, licensing-7.0.29-pkg.zip).

8. Extract the package.

A directory is created, called 1icensing-<version number> (for example,
licensing-7.0.29).

This directory contains several files. However, you only need di-license-
admin-<version number>-winnt.exe.

Requesting a License

You can import a machine information (info) file to populate the DI-License-
Admin utility with another machine's name, operating system, and machine ID.
You use this option when you need to request a license for use on another
machine (either Windows or Linux).

1. If you have not already, move the info file to the Windows computer with
Internet access that can run the DI-License-Admin utility.

NOTE: The info file is created in the section Using the exportinfo Utility to
Obtain Machine Information on page 19.
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. In the extracted licensing package you obtained from DI Download,

double-click di-license-admin-<version number>-winnt.exe (for
example, di-license-admin-7.0.29-winnt.exe).

The User Account Control confirmation box opens, asking you to
confirm making changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable file.

. Click Yes.

The DI-License-Admin utility starts.

4. Click the Request Licenses tab.
. Select File > Import Machine Info.

ﬁ Dl-License-Admin
File Help

Import Machine Info... I}

Export Machine Info...

i [ Insight
Import Request File... SRS

Exit Alt+F4

M ame: |J ohin Smith

. In the Import Machine Info dialog box, select the info file that you

created and click Open.

On the left side of the dialog box, the Machine Name, Operating
System, and Machine ID boxes are populated with the machine
information from the info file.

On the right side of the dialog box, the Applications to License box is
populated with the licenses you can request.

. Complete the Customer Information section.

Installing Diver Platform Server

24



Diver Platform 7.1

'ﬁ] Dl-License-Admin - *
File Help

Manage Licenses Request Licenses

Use thiz form to request licenses for Dimenzsional Insight applications. A license file will be emailed to the address you
zpecify.

Customer Information
Marne: |J ohin Smith Phore: |555-555-555

Compary: |Dimensi0nal Insight Email: |ismith@dimins.com

8. Specify details about the server-side licenses that you want to request:

a. Inthe Applications to License box, select the license that enables
the server-side software that you purchased. For example, if you
purchased Diver Platform Server 7.1 for Linux, select Diver Platform
7.1 Bl - DivelLine <port>.

The Define Port-locked Information dialog box opens.
b. Enter the port number that you want to use.

You must specify a unique port number for every virtual
environment in your deployment.

TIP: The default port number is 2130, however you can use any
number that you want.

c. If you know the number of users of each type that you purchased
access for, complete the remaining fields. Otherwise, Dimensional
Insight Customer Support can find this information when they create
your license.

d. Click OK.

The options that you specified display as a new entry in the
Applications to License box.

e. Repeat Steps a through d to request a server-side license for each
virtual environment on your machine.

NOTE: If you plan to install Bridge, Dimensional Insight recommends
that you request an additional server-side license. When
implementing Bridge, you typically install an extra DiveLine that only
Bridge connects to.

9. In the Applications to License box, select the remaining licenses for the
products that you purchased.

For example, if you purchased Diver Platform, select Developer Package
7.1.
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10. In the Comments/Questions box, specify any additional purchases, such
as Input Tables, Measure Factory, or Help Desk, and include any
comments or questions that you have. Dimensional Insight recommends
that you also provide the media access control (MAC) address of the
machine that you want to request the licenses for (the one that was used
to create the machine information file). For example:

Comments/Guestions:

MAC Address: 28-02-44-77-84-E3

NOTE: If installed on a virtual machine and that machine is relocated, a
new license is required. This can be avoided by ensuring the virtual
machine is installed with a fixed MAC address. For more information, see
http://kb.vmware.com.

11. Click Submit to open the Submit License? dialog box showing your
selections.

12. Click Yes to submit the license request.
13. Click OK to acknowledge the submission.

ﬁ License Information Submitted X

The license key request has been submitted

14. Click Save to store the license request file.

15. If necessary, move the request file to the Linux server.

16. On the Linux server, move the request file to the /di/platform/licenses
directory by entering the following command:

sudo mv <request-file-name>.request
/di/platform/licenses

Using the register Utility to Install a License File

After you receive your license file from Dimensional Insight, install it on your
server, inclucing
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the licenses that enable ProDiver and Workbench, which are installed on users'
computers.

TIP: After installing a new license, restart DivelLine and Tomcat, and close and
reopen the software to update the license information.

1. Copy the license zip file to the Linux server.
2. Copy the zip file to the /di/platform/licenses folder.
sudo mv <filename>.zip /di/platform/licenses
3. Navigate to the /di/platform/licenses folder.
cd /di/platform/licenses
4. Unzip the file.
sudo unzip <filename>.zip
5. Confirm that the license file is extracted
1ls

B S 1s
c3931_chris-virtualbox_platform71_p21360_m202211.license

<

TIP: Take note the name of the license file. You will use it later in this
procedure.

6. Navigate to the /di/platform/executables folder.
cd /di/platform/executables

7. Confirm that the register utility is in the directory.
1s

Jdi/platform/executables
S s

8. View the permissions for the register utility.
ls -1 register

The permissions display. If an x displays within the first group of letters
(for example, -rwxr--r--), you can run the utility. Proceed to the next
step

Installing Diver Platform Server
27



Diver Platform 7.1

10.

11.

12.

13.

14.
15.

If you do not have permission to run the utility:
a. Enable the execute permission.
sudo chmod a+x register
b. Verify that the permissions have changed.
ls -1 register
The permissions display as -rwxr-xr-x.
Move the register utility to the /di/platform/diveline/bin directory.
sudo mv register diveline/bin
Go tothe /di/platform/diveline/bin directory.
cd ../diveline/bin
Confirm that the register utility is in the directory.
1s
The contents of the directory display, including the register file.
Run the register utility, and specify which license file to install.

sudo ./register /di/platform/licenses/<license file
name>.license

Confirm that the installation was successful.
sudo ./register -1 all

A list of licenses that are currently installed on the server display, including
the license file that you just installed.

Repeat this process for each license file that you want to install.

Repeat this procedure for each environment.

Installing Diver Platform Server
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Installing DivelLine
Installing a DiveLine involves creating Diveline users, using administer
permissions, and modifying scripts using a text editor.

About Installing DivelLine

Diveline is the server component of the Diver Platform. DivelLine authenticates
users and controls access to data through Diver Platform clients such as
Workbench, ProDiver, DivePort, and DiveTab.

DI recommends that you do the following before you install DiveLine for your
site:

» Discuss the Diveline Security and Authentication options with Technical
Support to help determine the level and type of security for your DiveLine
setup.

« If you expect your Diveline clients to exchange information with users
outside of the company firewall, discuss firewall requirements with
Technical Support.

DiveLine typically resides behind a firewall on a corporate network. The system

administrators need to configure the firewall and Domain Name System (DNS)

so that internal and external customers can connect to Diveline using the same
host name and port number. Typically, you install DiveLine on port 2130, which
needs to be open in the corporate firewall.

To set up and configure Diveline inside a corporate network, consider the
following:

» Diveline communicates with clients using a proprietary protocol known as
Dimensional Insight DiveLine Protocol (DIDP). You might need to
configure your network to enable DIDP communications.

» Although configurable,by default, Diveline accepts client connections on
port 2130.

» Configure your routers and firewall so that DIDP traffic on port 2130 can
reach the Diveline service.

» Configure your firewall as a gateway for DIDP network traffic.

» Configure your firewall to transparently route two-way traffic on to the
correct port to the Diveline service.

» Typically, internal hosts (users inside the firewall) can connect directly to
the Diveline service, and external hosts connect to the network firewall,
which then routes traffic to DivelLine.

» Clients connect to the Diveline service using TCP/IP.
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« If client computers are running Windows operating systems, ensure that
the personal firewalls on these computers allow incoming connections
from the port (for example, port 2130) that is used by Diveline.

After installing DiveLine and Workbench, you can use Workbench tools to
perform the following server-settings tasks:

» Reset the default authentication type

» Create users and groups and properties

» Set directory aliases

» Configure access controls
NOTE: The Diveline service requires write access to Workbench projects
(/di/projects), as well as to its data root (/di/platform/dl-dataroot).

Installing and Configuring DiveLine
Prerequisite: Uncompress the di-diveline.tar.gz file, as shown in Extracting the

Server Installation Package on page 18, so that the /di/platform/diveline
directory contains the following files and subdirectories:

» bin—Directory containing executable files used by the server

e cgi-bin—Directory containing the executable file for Web Server
authentication

» docs—Directory containing a quick reference list for dicfg

» html—Directory containing html and dlk template files as well as a
README file used with Web Server authentication

« install-files—Directory containing files that are used when installing
Diveline, some files of which need to be copied to other directories

» samples—Directory containing two sample models and DiveBooks for
testing DivelLine

o ENCRYPTION—The OpenSSL license file
» INSTALL—Installation notes for 7.1
« install-di-diveline—The installation shell script
 README—Directory contents and support email address
NOTE: Text is case-sensitive in Linux.
To install and configure DivelLine:
1. Navigate to the /diveline directory by entering the following command:
cd /di/platform/diveline
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2. Check the directory contents for the install-di-diveline installation script by
entering the following command:

1s

3. View the permissions for the install-di-diveline installation script by
entering the following command:

ls -1 install-di-diveline

The permissions display. If the permissions are -rwxr-xr-x, you can run
the utility. If you do not have permission to run the utility:

a. Enable the execute permission.
sudo chmod 755 install-di-diveline
b. Verify that the permissions have changed.
ls -1 install-di-diveline
The permissions display as -rwxr-xr-x.
4. Run the install script by entering the following command:

sudo sh install-di-diveline

g $ sudo sh install-di-diveline
Welcome to the DI-DivelLine installation script.

This install script will first ask you a series of questions.
At the end, it'll ask you if you want to go ahead and do the install.
Mothing will be modified until after that point.

Defaults for questions will appear in square brackets []. Hitting
carriage return will automatically choose those defaults. If you
don't know what to do, trust the defaults.
To abort the installation, hit Control-C.

Verifying current directory...
Found installation files.

Where should DI-Diveline store configuration files and temporary files?
di/solution/dl-dataroot i

The script begins with useful information about the question and answer
process that follows including how to accept default suggestions or
exiting the script. The answers given in this step are based on the fact that
the server package was unzipped in the /di/platform directory.

NOTE: Press Enter to confirm the default, shown in brackets, or enter your
response. Use y to answer yes and n to answer no.

The questions are:
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Where should DI-DivelLine store configuration files and
temporary files? [/di/solution/dl-dataroot]

The default location is /di/platform/dl-dataroot and needs
manual entry if it is verified as the correct location.

NOTE: Verify the location of your d1-dataroot directory before
accepting the default or entering a new location.

What level of security should be configured for DI-

DiveLine? [2]
The default security level is 2.
There are three options to choose from:

° Level 0—No security checking. All users have access to all
models and DiveBooks in the models directory.

o Level 1—Security checking is based on a web login. If a model
is not listed in the configuration file, then all users have access
to it.

o Level 2—Security checking based on a web login. If a model is
not listed in the ACL file, then no users have access to it.

Do you want to install a sample model and divebook? [v]
The default is y, or yes.
Go ahead and install? [y]

The default is y, or yes.

If not already installed, the script prompts you to create a new RSA private
key and certificate files by entering information.

NOTE: A DI best practice is to create the private key and certificate files
during the Diveline installation.

For example:

Country Code - US

IMPORTANT: The country code must be two characters long.
State/province - MA

Location - Burlington

Enter organization - Dimensional Insight

Server name - ubuntu

Email address - jsmith@dimins.com
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OK. Go ahead and install? [y] vy
Security Level: 2
Authentication Type: own
Debug Level: @
one or both keypair files missing, generating new keypair
All fields are required.
Enter country code: US
Enter state/province: MA
Enter location: Burlington
Enter organization: Dimensional Insight
Enter server name: ubuntu
Enter email address: jsmith@dimins.com
Generating a 2048 bit RSA private key
Installing keypair
Done. You'll still need to:
- edit bin/init-di-diveline to set the username, base directory, dataroot, and
port number
- make sure you have a license installed
- optionally configure the system to run bin/init-di-diveline on boot
- Create a diveline admin user, with licensing set to Developer so you can logi
n

The script places the privatekey.txt and certificate.pem files in the
/di/platform/dl-dataroot/config directory.

Alternatively, you can create the keypair files after the DiveLine
installation. See Creating and Configuring an Encryption Key for
instructions.

Navigate to the /di/platform/dl-dataroot/ directory by entering the
following command:

cd /di/platform/dl-dataroot/
View permissions for /config by entering the following command:
1ls -1

The permissions display. If the permissions are -rwxrwxrwx, you can open
and modify the directory and its contents. If you do not have permission:

a. Enable the execute permission.
sudo chmod at+rwx config

b. Verify that the permissions have changed.
ls -1 config
The permissions display as drwxrwxrwx.

Verify that the keypair files (privatekey.txt and certificate.pem) are created
successfully:

1s

Navigate to the /di/platform/diveline/bin directory by entering the
following command:
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10.

11.

cd /di/platform/diveline/bin

Confirm that the init-di-diveline file is in the directory by entering the
following command:

1s
The contents of the directory display, including the init-di-diveline file.

View the permissions for the init-di-diveline file by entering the following
command:

ls -1 init-di-diveline
The permissions display. If the permissions are -rwxrwxrwx, you can
modify the file. If you don't have permissions to edit the file:
a. Enable the execute permission.
sudo chmod a+rwx init-di-diveline
b. Verify that the permissions have changed.
ls -1 init-di-diveline
The permissions display as -rwxrwxrwx.

Open the init-di-diveline script with a text editor, such as gedit, by
entering a command similar to the following:

gedit init-di-diveline

The text editor opens.

[73:3:213/3:2:2:313:2:3:2:2:3/212/2:3:8:3:213:3:2:2/3/3:8:2:3:3:2:3:3:28:312/23:312/2/313:3:3:2:3/32/2/22:8:3:3:3:3:212/2/3:8:2:3:2:3:3:2:2/313.3:313]

# Edit these variable assignments to suit your installation

# This is the user whose permissions will apply to everything the di-diveline
# does. (If not set, the script will not attempt to 'su')
DIDLUSER=diveline

# Important directory and port number settings
DIBASE=/difsolution

DIDATAROOT=SDIBASE/dl-dataroot
DIBINDIR=SDIBASE/diveline/bin
DISERVICE=di-service

# Diveline clients such as ProDiver expect port 2130 unless told otherwise
DIPORTNUM=2131

# UMASK override. Uncomment if desired, leave alone if unsure.
#UMASK=002

# End of user-modifiable section

The graphic displays the editable section of the script. The variable values
are specific to the installation described in this guide.
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12. For this installation, accept the variable defaults or make edits where
necessary:

DIDLUSER=diveline—The name of the user that runs the DivelLine
server

DIBASE=/di/platform—The location of the base DI Platform
directory

DIDATAROOT=$DIBASE/dl-dataroot—The location of the Diveline
config, acl, cache, log, and data directories

DIBINDIR=S$DIBASE/diveline/bin—The location of the Diveline
executable files

DISERVICE=di-service—The name of the existing di-service
DIPORTNUM=2131—The listening port for DiveLine on the server

NOTE: Specify the port number that you chose when requesting a
license. Port 2130 is the default.

13. Save and close the init-di-diveline file.

Creating an Administrator and a Test User

This procedure uses the dicfg command line tool to create an administrator and
a test user for the initial DiveLine configuration.

NOTE: Setting environment variables is dependent on the shell you are using.
This procedure uses the following dicfg format to create the administrator and

test user:

./dicfg -dataroot S$DIDATAROOT <dicfg commands>

$SDIDATAROOT is the path to /d1-dataroot that is specified in the init-di-diveline

file.

To create users for Diveline:

1. Gotothe /executables directory.

cd /di/platform/executables

2. View the permissions for dicfg.
ls -1 dicfg

The permissions display. If the permissions are -rwxrwxrwx, you can
create users. Proceed to step 3.

If you do not have permission to create users:

Enable the execute permission.

sudo chmod at+rwx dicfg
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 Verify that the permissions have changed.
ls -1 dicfg

The permissions display as -rwxrwxrwx.

3. Create the administrator user ID.

sudo ./dicfg -dataroot /di/platform/dl-dataroot add
user -user <admin username> -password <admin password>
—administrator true

For example:

sudo ./dicfg -dataroot /di/platform/dl-dataroot add
user -user admin -password adminpassword -
administrator true

. Create the test user ID.

sudo ./dicfg -dataroot /di/platform/dl-dataroot add
user -user <test user name> -password <test user
password>

For example:

sudo ./dicfg -dataroot /di/platform/dl-dataroot add
user -user tester -password testuserpassword

Creating a DivelLine Linux System User

To run the Diveline service on a Linux machine, you must create an
Administrative User account. For example, you might create a new user with the
account name of "diveline." This user must have the right to "Log On As a
Service" and have a strong password.

Your Linux administrator might have created a system user for DiveLine prior to
the installation process. If so, record the name and password of the Diveline
user, or contact your administrator for assistance.

To create a Linux system user:
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1. On the left panel, click the System Settings icon

The System Settings page opens:



System Settings

All Settings
Personal
E O &
Appearance Brightness & Language Online
Lock Support Accounts
Hardware
N
au‘-;‘ =%
Bluetooth Color Displays Keyboard

Printers Sound Wacom Tablet

I

System

'
.

o B O

Backups Details Software & Time & Date
Updates

O

Security & Text Entry
Privacy

(v

v/ (o
Mouse & Network
Touchpad

O (o

Universal User
Access Accounts

Power

2. Double-click User Accounts .

The User Accounts dialog box opens.

User Accounts

AllSettings User Accounts

& Unlock

My Account

Account Type
Language

Login Options
Password
Automatic Login

Last Login

Chris

Administrator

English (United States)

Logged in History

Show my login name in the menu bar

3. On the toolbar, click Unlock to enable editing.

The Authenticate dialog box opens.

: Authenticate

Authentication is required to change user data

An application is attempting to perform an action that requires
privileges. Authentication is required to perform this action.

Password: ||

+ Details

Cancel | Authenticate |

Diver Platform 7.1
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4. Enter your Password, and click Authenticate.
5. On the bottom left of the User Accounts window, click the plus sign .

The Add account dialog box opens.

Add account

Account Type @ Standard -

Fullname ||

Username v

Cancel

6. In the Add account dialog box":

» Select the Account Type Administrator.

¢ n the Full name and Username boxes, enter diveline, or another
name of your choosing for running the Diveline service,

NOTE: Use the name that you identified for the DIDLUSER in Step 12
of Installing and Configuring DiveLine on page 30.

7. Click Add.

Re-enter your password when prompted.

The new account is now listed under Other Accounts.
8. Click Account Disabled.

The changing password dialog box opens.
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Changing password for
diveline

Action | Setapassword now

New password | |

Confirm password |

("] show password

How to choose a strong password Cancel Change

. Enter a password in the New password and Confirm password boxes.
10. Click Change to display the updated diveline user account.

The dialog box closes and the field next to Password changes to indicate
a password is in use.

diveline

Account Type Administrator
Language English (United States)

Login Options

Password | ssses

Automatic Login OFF]
LastLogin — History

11. To enable automatic login for the Diveline account, next to Automatic
Login, click OFF.
The option changes to ON and turns orange.
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User Accounts

Allsettings User A

My Account
jsmith diveline
‘_ jsmith
Other Accounts AccountType Administrator

diveline i i
el (A Language English (United States)
Login Options

Password s

Automatic Login m:]

LastLogin — History

12. On the toolbar, click Lock and close the window.

Creating and Configuring an Encryption Key

Use the Java genkey tool, located in the /executables directory, to create an
additional private key and certificate for encrypting software. Follow the
instructions in this topic if you did not use the install-di-diveline script to create
the privatekey.txt and certificate.pem files during the DivelLine installation.

Complete the following steps:
1. Gotothe /di/platform/executables directory.
cd /di/platform/executables
2. Use genkey and the following syntax to create an encryption key:

./genkey <country> <state> <location> <organization>
<server name> <email address>

For example:

./genkey US MA Burlington Dimensional Insight ubuntu
Jjsmith@dimins.com

3. Gotothe /di/platform/dl-dataroot directory,
cd /di/platform/dl-dataroot

4. View permissions for /config.
1ls -1
The permissions display.

If the permissions are -rwxrwxrwx, you can open and modify the directory
and its contents. Proceed to step 5.
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If you do not have permission:
a. Enable the execute permission.
sudo chmod a+rwx config
b. Verify that the permissions have changed.
ls -1 config
The permissions display as drwxrwxrwx.

. Move the privatekey.txt and certificate.pem files to the /d1-
dataroot/config directory.

mv privatekey.txt certificate.pem /di/platform/dl-
dataroot/config

. Go to the /config directory.
cd /di/platform/dl-dataroot/config

. Verify that the privatekey.txt and certificate.pem files are present in the
/config directory.

1s

Starting and Stopping the DivelLine Service
You can manually start, stop, and check the status of the Diveline service by
using the init-di-diveline file in the /di/platform/diveline/bin directory.

IMPORTANT: Before you start DiveLine for the first time, check the permissions
of your /di/platform/dl-dataroot directory and the contents. If the
permissions are -rwxrwxrwx, you can run the utility. If you do not have
permission:

. Navigate to the /di/platform directory by entering the following
command:

cd /di/platform

2. Check the permissions by entering the following command:

ls -1 dl-dataroot
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$ 1s -1 dl-dataroot

@

13:51
13:51 acl.dir
13:51
13:51
13:51
13:51
13:51
13:51
13:51
S

-

root root
root root
root root
root root
root root
root root
root root
root root
root root

0 o w

0o oo m

=
1
2
2
=
=
2
2
=

e e S e
™

o

3. Enable the execute permission.

sudo chmod -R a+rwx dl-dataroot

NOTE: This changes the permissions for the dl-dataroot directory and it's
contents.

4. Verify that the permissions have changed.
ls -1 dl-dataroot

Navigate to the /di/platform/diveline/bin directory and enter the
following commands to start, stop, restart, and check the status of the DiveLine
service:

« Start Diveline by entering the following command:
sudo sh init-di-diveline start

 Stop Diveline by entering the following command:
sudo sh init-di-diveline stop

» Restart Diveline by entering the following command:
sudo sh init-di-diveline restart

o Check the status of a running Diveline (returns pid, port #, and path to
dl-dataroot directory) by entering the following command:

sudo sh init-di-diveline status

Verifying the Diveline Installation

Now that you can start and stop DivelLine, you can test the service to verify that
it is running properly.

To verify DivelLine:
1. Ifitis not running, start DiveLine.:

sudo sh /di/platform/diveline/bin/init-di-diveline
start
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2. Connect to the Diveline port on the server using the following command
syntax:

telnet <servername> <port number>

For example:
telnet ubuntu 2131
3. When you are connected, enter 2.
The DiveLine point release displays and validates the DiveLine installation.

?

DI-DivelLine 7.0 (56.2) SSL 64-bit

Start-up was completed successfully.
5]

4. Enter quit.
The connection closes.
NOTE: Alternatively, you can confirm a successful installation by connecting to

your server using a client, such as ProDiver. When connecting from a client,
enter the IP address of the Linux server.

Starting DiveLine Automatically at System Boot

To enable Diveline to start automatically at system boot, you must configure
your system startup scripts to include the path to the init-di-diveline file. Various
versions of Linux have their own files where an administrator can list commands
to run at startup. For more information, see to your system administrator or
vendor documentation.
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Installing Java and Tomcat

To use Diveline and most client applications such as Workbench, DivePort,
DiveTab, and more, you need to install Java and Tomcat software.

Downloading Java
At this point in the installation process, you must install (or have already
installed) Java SE version 10 or later on your machine.

Prerequisite: Uninstall any older versions of Java SE.
This procedure uses OpenlJDK.

NOTE: Consult with your Linux administrator to verify if they have downloaded
the JDK package to your /di/platform/downloads directory, as well as set
permissions on all directories in the DI structure.

NOTE: The following procedure is only necessary if JDK is not already installed
on your computer.

To download the software, complete the following steps:

1. Open a web browser.
2. Open the Java Development Kit Builds page:

https://jdk.java.net/java-se-ri/11/

NOTE: The appearance of the website can change over time.

The Java Platform, Standard Edition 11 Reference Implementations page
opens.

44


https://jdk.java.net/java-se-ri/11

Diver Platform 7.1

jdk.java.net Java Platform, Standard Edition 11 Reference
GA Releases Implementations
JDK 15

The official Reference Implementation for Java SE 11 (JSR 384) is based solely upon
open-source code available from the JDK 11 Project in the Open|DK Community.
This Reference Implementation applies to both the Final Release of SR 384 (Sep
2018) and Maintenance Release 1 (Mar 2019)

Early-Access
Releases

The binaries are available under the GNU General Public License version 2, with the
Classpath Exception

These binaries are for reference use only!

Reference

Implementations These binaries are provided for use by implementers of the Java SE 11 Platform
va SE 15

J Specification and are for reference purpeses only. This Reference Implementation
has been approved through the Java Community Process. Production-ready binaries
under the GPL are available from Oracle; and will be in most popular Linux
distributions.

RI Binary (bulld 11+28) under the GNU General Public License version 2

Feeaback = Linux/x64 Java Development Kit (sha256) 178.9 MB
Report 2 bug = Windows/x64 Java Development Kit (sha256) 178.7 MB
Arcnive

Rl Source Code

The source code of the Rl binaries is available under the GPLvZ in a single zip file
(sha256) 178.1 MB.

International use restrictions

Due te limited intellectual property protection and enforcement in certain
countries, the |DK source code may only be distributed to an authorized list of
countries. You will not be able to access the source code if you are downloading
from a country that is not n this list. We are continuously reviewing this list for
addition of other countries

| ORACLE|

3. Click Linux/x64 Java Development Kit, and download the file.

The Opening download verification dialog box opens.

Opening openjdk-11+28_linux-x64_bin.tar.gz

You have chosen to open:
[l openjdk-11+28_linux-x64_bin.tar.gz

which is: Gzip archive (179 MB)
from: https://download java.net

What should Firefox do with this File?

~)save File

Archive Manager (default) ~

[ Do this automatically For Files like this from now on.

Cancel oK

4. Select Save File.
5. Click OK.
The software is saved to the default download directory.

6. Navigate to the file and move it to the /di/platform/downloads
directory on your Linux server or VM.

sudo mv openjdk-11+28 linux-x64 bin.tar.gz
/di/platform/downloads
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Navigate to the /di/platform/downloads directory.
cd /di/platform/downloads

Verify that the file copied correctly.
1s

Close the browser.

See Installing the Java Development Kit for instructions on how to install the
Java software on a Linux server.

Installing Java Development Kit

Complete the following steps to install the software on a Linux machine. This
procedure describes how to install the openjdk-11+28_linux-x64_bin.tar.gz
package file.

Prerequisite: Download the latest version of the Java SE development kit.

NOTE: The individual steps required to install the software might vary at your

site.

To install Java:

1.

Go to the /di/platform/downloads directory.
cd /di/platform/downloads

Extract the JDK file.
sudo tar -xvzf openjdk-11+28 linux-x64 bin.tar.gz
The -xvzf arguments do the following:

o x—Extracts the files from the archive

o v—Lists all files as they are processed

e z—Uncompresses the files

o f—Names the file you are uncompressing

Press Enter to unpack the JDK package and create the jdk-11
subdirectory.

Change to the jdk-11 directory by entering the following command:
cd jdk-11

4. View the directory contents by entering the following command:
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1s

$ cd jdk-11
S 1s
release

: s

About Setting up an HTTPS Connection

The DivePort and NetDiver clients, can reside outside of the company firewall,
must run over a secure Hypertext Transfer Protocol (HTTPS) with Transport
Layer Security (TLS) connections to protect and ensure the integrity of data
passing over the network.

An important part of the secure connection is obtaining, or creating, a certificate
that guarantees message privacy and integrity. You must purchase and install a
certificate on all servers that interact with DI web clients.

A certificate authority creates a digital TLS certificate, to establish a secure
encrypted connection between a browser and a server. Whenever you run
DivePort or NetDiver, the web browser points to a secured domain that requires
a TLS handshake to authenticate both the server and the client.

A digital certificate verifies the identity of the requester and certifies that the
requester meets all requirements to receive the certificate. The certificate
provides the following security benefits:

* It contains personal information to help identify and trace the owner.

* It contains the information that is required to identify and contact the
issuing authority.

* Itis designed to be tamper-resistant and difficult to counterfeit.

A digital certificate issued by a certificate authority provides proof for verifying
the identity of online entities using public and private keys.

Before enabling an TLS connection, you must install a site certificate using one
of the following options:

» Purchase and install a certificate from a standard Certificate Authority,
such as VeriSign or DigiCert. To request a certificate, you must create a
Certificate Signing Request (CSR) from your server. Working with the
issuer or instructions available, install the certificate in the Tomcat
directory.

» Create a self-signed certificate using the Java genkey tool. Typically, you
might generate and install a temporary self-signed certificate if you are in
a trial or test phase and not concerned about receiving browser security
warnings.
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Before enabling the HTTPS connector, be sure that you have already installed
the digital certificate in the Tomcat directory. This task is detailed in Enabling
the Default HTTPS Connector.

Downloading Apache Tomcat
You must install (or have already installed) Apache Tomcat on your machine.

Dimensional Insight recommends that DivePort, NetDiver, and DiveTab software
run on a Tomcat web server.

NOTE: DI recommendsTomcat 9.0.
To download Apache Tomcat:

1. Open a web browser.
2. Open the Apache Tomcat home page at:

http://tomcat.apache.org

The URL for this web site can change over time, but the home page is
similar to the following:
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< C U B https://tomcat.apache.org

Apache Tomcat®

search... |E| Apache Tomcat
Apache Tomcat The Apache Tomcat™® software is an open source implement.
I Jakarta Annotations and Jakarta Authentication specification:
Taglibs
Maven Plugin The Jakarta EE platform is the evolution of the Java EE platfor
earlier implement specifications developed as part of Java EE
Download
which version? The Apache Tomcat software is developed in an open and pa
Tomcat 10 project is intended to be a collaboration of the best-of-breed
Tomcat 9 To learn more about getting invelved, click here.
Tomcat 8

Apache Tomcat software powers numerous large-scale, miss

Tomcat Migration Tool
users and their stories are listed on the PoweredBy wiki page

for Jakarta EE
Tomcat Connectors

) Apache Tomcat, Tomcat, Apache, the Apache feather, and thi
Tomcat Native

Taglibs
e Tomcat 8.5.76 Released
Archives
Documentation The Apache Tomcat Project is proud to announce the release

Tomeat 10.1 (alpha) Java EE 7 platform. The notable changes compared to 8.5.75

Tomeal 100 « Correct a regression in the fix for 65454 that meant thi

executor.

TRl « Imnrove the detection of the Linux dunlicate accent hi

3. On the left pane, under Download, click Tomcat <version number> .

The Tomcat <version number> Software Downloads page opens:
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Tomcat 9 Software Downloads

Welcome to the Apache Tomcat® 9.x software download page. This page provides download links for obtaining the latest version of Tomcal
well as links to the archives of older releases.

Unsure which version you need? Specification versions implemented, minimum Java version required and lots more useful information maj
'which version?' page.

Quick Navigation

KEYS Browse | Archives

4. In the Quick Navigation section, click the <version number> to open
the Binary Distributions section:

9.0.59

Please see the README file for packaging information. It explains what every distribution contains.

Binary Distributions

« Core:
o zip (pgp, shas12)
@ T
o 32-bitWindows zip (pgp, shas12)
= B4-bit Windows zip (pgp, sha512)
o 32-hit/64-bit Windows Service Installer (pgp, sha512)
« Full documentation:
© tar.gz (pgp. shas12)
» Deployer:
© Zip (pgp, sha512)
o tar.gz (pgp. shas12)
* Embedded:
© tar.gz (pgp. shas12)
© Zip (pgp. sha512)

5. Click the tar.gz link.

The Opening download verification dialog box opens.
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Opening apache-tomcat-9.0.59.tar.gz

You have chosen to open:

ll apache-tomcat-9.0.59.tar.gz

which is: Gzip archive (11.0 MB)
from: https://dlcdn.apache.org

What should Firefox do with this File?
Open with | Archive Manager (default) v

O save File

Do this automatically for Files like this from now on.

Cancel OK
6. Select Save File.
7. Click OK.
The file is downloaded to the Downloads directory on your local
computer.

8. Navigate to the file location.

9. Move the file to the /di/platform/downloads directory

sudo mv apache-tomcat-<version number>.tar.gz
/di/platform/downloads

10. Navigate to the /di/platform/downloads directory
cd /di/platform/downloads
11. Verify that the file moved correctly by entering the following command:
1s
12. Close the web browser.
Installing Apache Tomcat
This page describes how to install Apache Tomcat using the apt-get utility. Apt-
get is a free package management command line program. Apt-get works with

Ubuntu’s APT (Advanced Packaging Tool) library to perform the installation,
deletion, or upgrading of new or existing software packages.
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site. depending on the distribution and version you are using.
NOTE: DI recommends Tomcat 9.0.

To install Apache Tomcat:

1.

Navigate to the /di/platform/downloads directory.
cd /di/platform/downloads

Decompress the apache-tomcat-<version number>.tar.gz file.

sudo tar -xvzf apache-tomcat-<version number>.tar.gz

The -xvzf arguments do the following:
o x—Extracts the files from the archive
» v—Lists all files as they are processed
o z—Uncompresses the files
o f—Names the file you are uncompressing

The file unpacks and creates the apache-tomcat-<version number>
subdirectory.

Go to the Apache Tomcat folder.

cd apache-tomcat-<version number>

Update your apt-get package lists by entering the following command:

sudo apt-get update

$ sudo apt-get

update
it:1 http://us.archive.ubuntu.com/ubuntu focal InRelease

2 http://us.archive.ubuntu.com/ubuntu focal-updates InRelease
it:3 http://us.archive.ubuntu.com/ubuntu focal-backports InRelease
4
5

http://security.ubuntu.comfubuntu focal-security InRelease
https://esm.ubuntu.com/infrafubuntu focal-infra-security InRelease
:6 https://esm.ubuntu.com/infra/ubuntu focal-infra-updates InRelease
Reading package lists... Done

NOTE: The apt-get utility works on a database of available packages. This

command updates the database with any newer packages.

Start the Tomcat installation by entering a command similar to the
following:

sudo apt-get install tomcat<version number>
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$ sudo apt-get
install tomcat?

Reading package lists... Done
Building dependency tree
Reading state information... Done

NOTE: Apt-get installs Tomcat to the /etc/tomcat<version number>
directory.

6. Navigate to the /etc/default directory.
cd /etc/default

7. View the permissions for the tomcat<version number> configuration file
by entering a command similar to the following:

ls -1 tomcat<version number>

The permissions display. If the permissions are -rwxrwxwx, you can run
the utility. Proceed to step 9.

If you do not have permission to run the utility:
a. Enable the execute permission.
sudo chmod atrwx tomcat<version number>
b. Verify that the permissions have changed.
ls -1 tomcat<version number>
The permissions display as -rwxrwxrwx.

NOTE: If you are using SELinux on Red Hat 7.x, ensure that the webdata
and webapps folders have the appropriate filesystem labels for Tomcat to
be able to access them (for example, tomcat var 1ib t). For more
information, see Red Hat documentation.

8. Open the tomcat<version number> configuration file with a text editor,
such as gedit, by entering a command similar to the following:

gedit tomcat<version number>

Here is an example of the configuration file:
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tomcat9 (/etc/default) - gedit

tomcat9

1 TOMCAT9 USER=tomcat®

2

3 TOMCAT9_GROUP=tomcat9

4

5 TOMCAT9_SECURITY=no

6 # The home directory of the Java development kit (JDK). You need at least

7 # JIDK version 8. If JAVA_HOME is not set, some common directories for

8 # OpenJDK and the Oracle JDK are tried.

9 #JAVA_HOME=/usr/Llib/jvm/java-11-openjdk-amd64|

16

11 # You may pass JVM startup parameters to Java here. If you run Tomcat with

12 # Java 8 instead of 9 or newer, add "-XX:+UseG1GC" to select a suitable GC.

13 # If unset, the default options will be: -Djava.awt.headless=true

14 # JAVA_OPTS="-Djava.awt.headless=true"

15 JAVA_OPTS="-Djava.security.egd=file:/dev/. furandom -Djava.awt.headless=true -Xms512m -Xmx1024m -
XX:MaxPermSize=256m -XX:+UseConcMarkSweepGC"

16

17 # To enable remote debugging uncomment the following line.

18 # You will then be able to use a Java debugger on port 80@.

19 #JAVA_OPTS="S{JAVA_OPTS} -agentlib:jdwp=transport=dt_socket,address=8000,server=y,suspend=n"

20

21

22 # Java compiler to use for translating JavaServer Pages (JSPs). You can use all

23 # compilers that are accepted by Ant's build.compiler property.

24 #JSP_COMPILER=javac

25

26 # Enable the Java security manager? (true/false, default: false)

27 #SECURITY_MANAGER=true

28

TOMCAT9 USER=tomcat9 indicates the Tomcat user name on the machine.

Locate the Java opTs parameter (last line in the above figure) and replace
it with the following:

JAVA OPTS="-Djava.security.egd=file:/dev/./urandom -
Djava.awt.headless=true -Xms512m -Xmx1024m -
XX:MaxPermSize=256m -XX:+UseConcMarkSweepGC"

Change the ToMCAT9 SECURITY variable value to no, and remove the
comment tag, #, at the beginning of the line.

Save and close the changed configuration file.

Change the ownership of webdata and operate on its files and sub-
directories to enable Tomcat to write files to the DI webdata directory.

sudo chown -R tomcat<version number>
/di/platform/webdata

For example:

To start, restart, and stop the Tomcat server, navigate to the apache-
tomcat-<version number>/bin directory with the following command:
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cd /di/platform/downloads/apache-tomcat-<version-
number>/bin

» Start Tomcat by entering the following command:
sudo ./startup.sh

» Stop Tomcat by entering the following command:

sudo ./shutdown.sh

chris@chris-VirtualBox: /di/platform/downloads/apache-tomcat-9.0.56/bin

$ sudo ./s
tartup.sh

Using CATALINA BASE: Jdifplatform/downloads/apache-tomcat-9.0.56
Using CATALINA_HOME: /di/platform/downloads/apache-tomcat-9.0.56
Using CATALINA TMPDIR: /di/platform/downloads/apache-tomcat-9.0.56
Using JRE_HOME: Jusr

Using CLASSPATH: /di/platform/downloads/apache-tomcat-9.0.56/bin/bootstrap
.jar:/di/platform/downloads/apache-tomcat-9.0.56/bin/tomcat-juli. jar

Using CATALINA OPTS:

Tomcat started.

/temp

S sudo ./s
hutdown.sh
i CATALINA BASE: /di/platform/downloads/apache-tomcat-9.0.56
CATALINA HOME: Jdi/platform/downloads/apache-tomcat-9.0.56
CATALINA TMPDIR: /di/platform/downloads/apache-tomcat-9.0.56
JRE_HOME: Jusr
CLASSPATH: /di/platform/downloads/apache-tomcat-9.0.56/bin/bootstrap
.jar:/di/platform/downloads/apache-tomcat-9.0.56/bin/tomcat-juli. jar
Using CATALINA OPTS:
NOTE: Picked up JDK_JAVA OPTIOMS: --add-opens=java.base/java.lang=ALL-UNMAMED -
-add-opens=java.base/java.lo=ALL-UNNAMED --add-opens=java.base/java.util=ALL-UNN
AMED --add-opens=java.base/java.util.concurrent=ALL-UNNAMED --add-opens=java.rmi
/sun.rmi.transport=ALL-UNNAMED

/temp

With Tomcat running, open a web browser and enter the URL to test the
Tomcat installation. Use the following format:

http://<server name>:8080
For example, http://localhost:8080

Press Enter to display a page similar to the following:
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Apache Tomcat/9.0.56 X

&« (] QO D localhost:z080 w5
Home Documentation Configuration Examples Wiki Mailing Lists Find Help
Apache Tomcat/9.0.56 # APACHE

™ ;
Recommended Reading: Server Status

% Security Considerations How-To
Manager App
Manager Application How-To _—
/ Clustering/Session Replication How-To fiEstenen

[ ( Dol Siart

NOTE: It is possible to install Tomcat using a system account that is not an
administrator, but this prevents full access to the machine. Be sure the
user that Tomcat runs as has file system access to Tomcat's installation
folder and subfolders, plus the DIl webapps and webdata folders.

Generating an SSL/TLS Self-Signed Certificate
If you decide to generate your own self-signed certificate, adhere to the
following prerequisites:

» Use a non-root user configured with sudo privileges
« Verify that the server has an installed Apache Tomcat web server
» Stop the Apache Tomcat service before beginning this process

NOTE: A self-signed certificate encrypts communication between your server
and any web-based clients. However, because this certificate is not signed by
any of the trusted certificate authorities included with web browsers, users

cannot use the certificate to validate the identity of your server automatically.

SSL/TLS works by using a combination of a public certificate and a private key.
The SSL/TLS key is kept secret on the server and is used to encrypt content sent
to clients. The SSL/TLS certificate is publicly shared with anyone requesting
content stored on the server. The certificate can also be used to decrypt the
content signed by the associated SSL/TLS key.

To generate a self-signed certificate:

1. Change to the JDK /bin directory by entering a command similar to the
following:

cd /di/platform/downloads/jdk-<version number>/bin

2. Generate a certificate for Tomcat with the keytool utility by entering a
command similar to the following:
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sudo keytool -genkey -alias tomcat -keyalg RSA -
validity 1460 -keystore /etc/tomcat<version
number>/keystore -keypass tomcat -storepass tomcat

After pressing Enter, the command prompts you to enter information
about your server that will be incorporated into the self-signed certificate
and visible to anyone viewing the certificate. Accept any defaults or enter
information specific to your server. The prompts appear as questions in
the following order:

What is your first and last name? — Do not enter your
common name, instead enter the Fully Qualified Domain Name
(FQDN) of the server. For example, portal.mycompany.com, Where
portal is the host name and mycompany . com is the domain name.
For this example, enter the host name of the server, ubuntu.

NOTE: Responses to the remaining command prompts are optional
but recommended.

What is the name of your organizational unit? —For
example, Bl Software.

What is the name of your organization?—For example,
Dimensional Insight.

What is the name of your City or Locality?— Forexample,
Burlington.

What is the name of your State or Province? — Forexample,
MA.

What is the two-letter country code for this unit? —For
example, US.

At the confirmation prompt, for example:

Is CN=ubuntu, OU=BI Software, O=Dimensional Insight,
L=Burlington, ST=MA, C=US correct? [no]

Type Y to confirm, and press Enter. N, or no, is the default.

3. Change to the Tomcat etc directory by entering a command similar to the
following:

cd /etc/tomcat<version number>

1s

Verify the creation of the keystore file by entering the following command:

The keystore certificate file is valid for 1460 days and can be renewed upon
expiration following the directions in this topic.
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NOTE: You can restart the Tomcat service or leave it closed and move to
the Enabling the Default HTTPS Connector for instructions on how to
edit the server.xml file.

Enabling the Default HTTPS Connector

To establish a connection between DivePort and NetDiver clients and Tomcat,
you must enable the HTTPS connector by editing the server.xml file.

1.

If Tomcat is running, stop it.

sudo /di/platform/downloads/apache-tomcat-<version-
number>/bin ./shutdown.sh

Go to the Tomcat directory (/etc/tomcat<version-number>)

cd /etc/tomcat<version-number>

Make a backup copy of the server.xml file called serverorig.xml

sudo cp server.xml serverorig.xml

$ sudo cp server.xml serverorig.xml

[sude] password for chris:

g o
jaspic-providers.xml serverorig.xml web.xml
catalina.properties logging.properties
context.xml I tomcat-users.xml
s

Verify that the file is copied correctly by entering the following command:
1ls

View the permissions of the server.xml file
ls -1 server.xml

The permissions display. If the permissions are -rwxrwxrwx, you can edit
the file.

If you do not have permissions:
» Enable the execute permission.
sudo chmod a+rwx server.xml
 Verify that the permissions have changed.

ls -1 server.xml

Open the server.xml file using a text editor, such as gedit.
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gedit server.xml

7. Locate the section beginning with befine an SSL/TLS HTTP/1.1

Connector on port 8443.

<!-- Define an SSL/TLS HTTP/1.1 Connector on port 8443
This connector uses the NIO implementation. The default
ssLImplementation will depend on the presence of the APR/native
library and the useOpenSSL attribute of the
AprLifecyclelListener.
Either JSSE or OpenSSL style configuration may be used regardless of
the SSLImplementation selected. JSSE style configuration is used below.
-——2
<l--
<Connector port="8443" protocol="org.apache.coyote.httpll.HttpliNioProtocol"
maxThreads="200" SSLEnabled="true" secure="true" scheme="https" clientAuth="false"
sslProtocol="TLS" maxHttpHeaderSize="8192" minSpareThreads="25" maxSpareThreads="75"
enablelLookups="false" disableUploadTimeout="true" acceptCount="100" URIEncoding="UTF-8"
keystorePass="tomcat" keystoreFile="etc/tomcat9/keystore">

8. Inthe "Define an SSL/TLS HTTP/1.1 Connector on port 8443" and
"Connector port" sections of the server.xml file, make the following edits:

a. Remove the commented lines beginning with "This connector..." and
ending with "used below".

b. After <Connector port= "8443", add the following attributes:

SSLEnabled="true"
maxHttpHeaderSize="8192"
minSpareThreads="25"
maxSpareThreads="75"
enablelLookups="false"
disableUploadTimeout="true"
acceptCount="100"
URIEncoding="UTF-8"
keystorePass="tomcat"
keystoreFile="/etc/tomcat9/keystore"

9. Remove the comment symbols, (<!-- and -->) around the <Connector
pPort= ... />section. The file appears as follows:

<!-- Define an SSL/TLS HTTP/1.1 Connector on port 8443--=>

<Connector port="8443" SSLEnabled="true" maxHttpHeaderSize="8192" minSpareThreads="25"
maxSpareThreads="75" enableLookups="false" disableUploadTimeout="true" acceptCount="160"
URIEncoding="UTF-8" keystorePass="tomcat" keystoreFile="/etc/tomcat9 /keystore"s>
=</Connector=

10. Save and close the server.xml file.
11. Start Tomcat.
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sudo /di/platform/downloads/apache-tomcat-<version-
number>/bin ./startup.sh

NOTES:

* When DivePort software generates URLs, non-ASClI characters are
encoded to ensure that the URL only contains ASCII characters. For these
generated strings, ISO-8859-1 or UTF-8 encoding is acceptable.

o If users intend to enter URLs that contain non-ASCII characters, set the
URIEncoding on the Tomcat connector according to the encoding that
they intend to use.

Verifying the HTTPS Connection

You can verify the HTTPS connection for Tomcat by opening a browser window
and connecting through the TLS port URL. The first time you attempt to connect
to your Tomcat web server through a self-signed certificate using HTTPS, you
can expect warnings from the browser when it attempts to authenticate with
Tomcat. You might encounter the following:

» A browser might display a warning message similar to "There is a problem
with this website's security certificate".

» The Microsoft Internet Explorer browser asks you to click the Continue to
this website (not recommended) warning message before opening the
Tomcat home page on the secure port.

* Most browsers allow you to accept the self-signed certificate permanently.

* If you restart the browser and enter
https://<servername>:<portnumber>, the default Tomcat home page
should display without a security warning.

NOTE: If you encounter any HTTPS errors when logging into Tomcat, refer to
your logs for troubleshooting information.

This procedure uses the Mozilla Firefox browser.
To verify the HTTPS connection, complete the following steps:
1. Open a browser window, and enter a URL with the following syntax:

https://<servername or IP address>:8443

For example:
https://localhost:8443

2. Press Enter to display the following security screen in the Firefox browser:
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Warning: Potential Security Risk Ahead

Firefox detected a potential security threat and did not continue to ubuntu. If you visit this site,
attackers could try to steal information like your passwords, emails, or credit card details.

Learn more...

Go Back (Recommended) Advanced...

3. Click Advanced to view additional information.

Warning: Potential Security Risk Ahead

Firefox detected a potential security threat and did not continue to ubuntu. If you visit this site, attackers could try
to steal information like your passwords, emails, or credit card details.

Learn more...

Go Back (Recommended) Advanced...

ubuntu:8443 uses an invalid security certificate.
The certificate is not trusted because it is self-signed.

Error code: MOZILLA_PKIX_ERROR_SELF_SIGNED_CERT

View Certificate

Go Back (Recommended) Accept the Risk and Continue

4. Click Accept the Risk and Continue to enable the connection to the
Tomcat web server.

The confirmation page displays.

NOTE: The confirmation page might differ depending on the version of
Tomcat.
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DivePort

Installing DivePort

DivePort is a web client that employs portlet web technology. A DivePort portal
consists of pages that contain portlet instances. DivePort enables you to create
and configure pages and their portlet instances. DivePort typically resides on
Apache Tomcat, a web application server, which you can access by using a web
browser.

Prerequisite: The successful installation of Apache Tomcat and Diveline. The
DivePort installation files are in the web-tools.zip file which comes bundled with
the Diver Platform Server package.

To extract and copy the DivePort installation files:
1. If Tomcat is running, stop it.
2. Navigate to the /di/platformdirectory.
cd /di/platform
3. Verify that the web-tools.zip file is present.
1ls
4. Unzip web-tools.zip file.

sudo unzip web-tools.zip

$ sudo unzip web-tools.zip

Archive: web-tools.zip
inflating: bridge.zip
extracting: dial-jar.zip
inflating: diveport.zip
extracting: netdiver.zip

6. Unzip diveport.zip.

sudo unzip diveport.zip
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64

7.

10.

11.

12.

13.

14.

15.

Navigate to the diveport directory.

cd diveport

View the unpackaged diveport.zip file.
1s

The unzipped DivePort package creates the following directories and file
in the diveport directory:

e /appdir
e /datadir
» context-file-template.xml

Copy the appdir directory to the /di/platform/webapps directory and
rename it to assign a DivePort portal name (for example, mydiveport).

sudo cp -r appdir /di/platform/webapps/mydiveport

Copy the datadir directory to the /di/platform/webdata directory and
rename it to the same DivePort portal name (for example, mydiveport).

sudo cp -r datadir /di/platform/webdata/mydiveport
Verify that the files were renamed and copied.

e 1s /di/platform/webapps

e 1ls /di/platform/webdata
Navigate to the /etc/init.d directory.
cd /etc/init.d
Determine the IP address of your Linux machine
ifconfig
jsmith@ubuntu: /etc/init.dS ifconfig
ens33 Link encap:Ethernet HWaddr 28:d2:44:77:8a:e3

inet addr:192.168.179.140 Bcast:192.168.179.255 Mask:255.255.255.0

inet6 addr: fe80::d72e:2c81:95c2:a46e/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1508 Metric:1

RX packets:18456 errors:0 dropped:® overruns:® frame:@
TX packets:5458 errors:0 dropped:® overruns:® carrier:@
collisions:® txqueuelen:1888

RX bytes:19805591 (19.8 MB) TX bytes:608962 (608.9 KB)

Note the IP address (inet addr) that displays.
For example, 192.168.179.140 is the IP address that displays in the figure.

Specify whether you want the DivePort name to display in the URL to your
portal (for example, https://www.<your server>.com/<DivePort
name>).
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(Recommended) To display <DivePort name> in the URL:
a. Navigate to the /di/platform/diveport directory.
cd /di/platform/diveport

b. Create a copy of the context-file-template.xml file and rename it to
the name of your DivePort portal file (for example, mydiveport.xml).

sudo cp -1 context-file-template.xml
mydiveport.xml

c. Verifythe permissions of the <DivePort name>.xml file.
ls -1 mydiveport.xml

The permissions display. If the permissions are -rwxrwxrwx, you can
open and modify the directory and its contents. Proceed to step 15
d.

If you do not have permission:
i. Enable the execute permission.
sudo chmod at+rwx mydiveport.xml
ii. Verify that the permissions have changed.
ls -1 mydiveport.xml
The permissions display as -rwxrwxrwx.
d. Open the <DivePort name>.xml file with a text editor, such as gedit.
gedit mydiveport.xml

The file opens in the text editor

<Context docBase="Enter DivePort War File Path Here" unpackWAR="false"
sessionCookiePathUsesTrailingSlash="false">
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</Context>

e. Edit the <DivePort name>.xml file to include the following changes:

"Enter DivePort War File Path Here" — The path to the
diveport.war file

For example:

/di/platform/webapps/mydiveport/diveport.war

"Enter DivePort Webdata Directory Here" —The path to
the webdata directory (dataroot)

For example:

/di/platform/webdata/mydiveport

"Enter DivePort WebApp Directory Here" —The path to
the webapps directory (approot)

For example:

/di/platform/webapps/mydiveport

"Enter DiveLine Server String Here" — The Diveline
server name

For example:

ubuntu:2131

"Enter Admin Username Here" — The DivelLine administrator
name, which is defined in Creating an Administrator and a Test

User on page 35.

For example:

admin

f. Remove uncomment this and set the following parameters:
and the surrounding comment markers (<!-- and -->).

For example:
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<Context

docBase

="/di/platform/webapps/mydiveport/diveport.war"

unpackWAR="false" sessionCookiePathUsesTrailingSlash="false" >
<Parameter

name="dataroot" value="/di/platform/webdata/mydiveport" />
<Parameter

name="approot" value="/di/platform/webapps/mydiveport" />
<Parameter name="diveline.server" value="ubuntu:2131" />
<Parameter name="diveline.admin-username" value="admin" />
(Optional) for single-sign-on with a CGI-mode

installation, set these parameters:
<Parameter name="diveline.web-auth-start-url" value="Enter DLCGI

DivePort URL Here"/>
<Parameter name="diveline.web-auth-finish-url" value="Enter Logoff

URL Here"/>
(Optional) If you need to permit HTTP connections:
<Parameter name="require-confidentiality" value="false" />
<CookieProcessor sameSiteCookies="lax" />

</Context>

IMPORTANT: If you do not require HTTP connections, comment out
the require-confidentiality parameter. If you permit HTTP
connections, you are allowing unsecured communications with
Diveline.

g. Save your changes and close the file.

Move the file that you just created (either mydiveport.xml or ROOT.xml) to
the Tomcat 1ocalhost directory.

sudo mv <file name>.xml /etc/tomcat<version-
number>/Catalina/localhost

Navigate to the /etc directory.
cd /etc

Change the ownership for the tomcat<version> directory to the Tomcat
user, identified in Installing Apache Tomcat on page 51.

sudo chown -R tomcat<version-number> ./tomcat<version-
number>

Change to the directory holding the atlcfg.cfg file.
cd /di/platform/dl-dataroot/config

Check the permissions of the atlcfg.cfg file.
1ls -1 atlcfg.cfqg
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21.

22.

23.

24.
25.

NOTE: The server IP address can change when you restart the server. The server
IP address shown in examples might change in different topics due to restarting

The permissions display. If the permissions are -rwxrwxrwx, you can open
and modify the directory and its contents. If you do not have permission:

a. Enable the execute permission.
sudo chmod a+rwx atlcfg.cfg
b. Verify that the permissions have changed.
1ls -1 atlcfg.cfqg
The permissions display as -rwxrwxrwx.
Open the file with a text editor, such as gedit.
gedit atlcfg.cfg

Locate the ACFG object, and insert the gateway ips attribute with IP
address information.

For example:

gateway ips={"192.168.179.140","127.0.0.1"}

Here is an example of the attribute in the atlcfg.cfg file:

version "1";
// Computer generated object language file
object 'ACFG' "main" {
security level=2,
auth_scheme="own",
debug=0,
user levels migrated="true"
[gateway ips={"192.168.179.140","127.0.0.1"}

Optionally, if not already configured, add an administrative user to the
atlcfg.cfg file.

NOTE: Remember to enter a comma at the end of all lines within the
ACFG object except the last one.

Save and close the file.
Start Tomcat

the test server.

Verifying the DivePort Installation

Verify that your DivePort installation is working by entering the DivePort URL in

a web browser.

Prerequisite: Download, install, and configure DivePort.
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Enter your DivePort URL with the following syntax:

https://<servername or IP address>:8443/<DivePort name>

For example:

https://ubuntu:8443/mydiveport

NOTE: If the server name does not work, use the IP address of the
DivelLine server.

If you have problems connecting to DivePort, review your logs and the
configuration changes made to the mydiveport.xml and atlcfg.cfg files. The
example URL reflects changes made in the Installing DivePort section.
Additionally, if the Linux server is running in a VM, verify that you have
configured the network connection options correctly. For example, the
Virtual Machine Settings > Network Adapter options for an Ubuntu
server appear as follows:

Virtual Machine Settings *

Hardware  QOptions

Device Summary Device status
T Memory 1GB Connected
[ Processars 1 Connect at power on
(= Hard Disk (5CSI) 20 GB )

*)CD/DVD (SATA) Using file autoinst.iso Network connection

“JCO/OVD 2 (SATA)  Using file C:Program Filesubuntulubu. . (®) Bridged: Connected directly to the physical network
Floppy Using file autoinst. fip Replicate physical network connection state
ElNetwork Adapter Bridged {Automatic)
USE Controller Present (COINAT: Used to share the host's IP address
l.£') Sound Card Auto detect (O Host-only: A private network shared with the host
f,!:]Printer Present (O Custom: Spedific virtual network

Epispl, Auto detect

=J isplay uto detec e

O LAM segment:
LAN Segments... | | Advanced...

2. In the Network connection section, enable the following options:

3.

a. Bridged: Connected directly to the physical network
b. Replicate physical network connection state

If you have successfully installed DivePort, the Welcome to DivePort
page opens.
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Dimensio
| N 5 I

DivePort

version 7.0 (56.2)

Username: Password:

| admin | |'-----

| Log©On |

0 2020 Dimensional Insight, Inc. All ights reserved. DivePort and The
Diver Solution trademarked by Dimensional Insight, Inc.

4. If you installed a self-signed certificate and you have not previously
logged in to the Linux server with a DI client, such as DivePort, the client
displays a Verify Certificate dialog box similar to the following:

The server requires enciyption, but prezented an unknown certificate.
Please verify the following and indicate whether or not you trust this
certificate. If you do, you will not be asked again.

Certificate Dwner: Dretails »x |
ubLintu

ul}
Burlington, kM4 US

Accept I Decline |

5. Click Accept to trust the certificate now and for all future logins.

Different browsers display different security warnings the first time you
log in to the server with a web-based DI client. If the dialog box presented
is different from the one shown above, follow the online instructions to
permanently accept the certificate.

6. Once connected and logged in to DivePort, click HELP > About to open

the About DivePort dialog box that lists the current version numbers of
Diveline and DivePort.



Diver Platform 7.1

7. Click OK to close the dialog box.
I N5SICG

About DivePort

DivePort

version 7.0 (56.2)
Diveline 7.0 (56.2)

& 2020 Dimensional Insight, Inc. All rights reserved.
DivePort and The Diver Solution trademarked by
Dimensional Insight, Inc.

| ok |

8. Click HELP > Help to open the Help system in a new tab in your browser.

NOTE: DivePort administrators have access to DivePort Adminstrator Help, as
well as DivePort User Help.

Appendix: DivePort Installation

The following optional process suppresses the name of your DivePort in the
URL:

1. Goto the /di/platform/diveport directory by entering the following
command:

cd /di/platform/diveport

2. Create a copy of the context-file-template.xml file and rename it
ROOT.xmlby entering the following command:

sudo cp -1 context-file-template.xml ROOT.xml

3. Open the ROOT.xml file with a text editor, such as gedit, by entering a
command similar to the following:

gedit ROOT.xml
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<Context docBase="Enter DivePort War File Path Here" unpackWAR="false"
sessionCookiePathUsesTrailingSlash="false" >
<!-- uncomment this and set the following parameters:
<Parameter name="dataroot" value="Enter DivePort WebData Directory Here"
/>
<Parameter name="approot" value="Enter DivePort WebApp Directory Here" />
<Parameter name="diveline.server" value="Enter DivelLine Server String Here" />
<Parameter name="diveline.admin-username" value="Enter Admin Username
Here" />
-—>
<l--for single-sign-on with a CGI-mode installation, uncomment and set
these parameters:
<Parameter name="diveline-web-auth-start-url" value="Enter DLCGI DivePort
URL Here" />
<Parameter name="diveline.web-auth-finish-url" value="Enter Logoff URL Here"
/>
-->
<!-- If you need to permit HTTP connections:
<Parameter name="require-confidentiality" value="false" />
-->
</Context>

4. Edit the ROOT.xml file to include the following changes:

* "Enter DivePort War File Path Here" —The path to the
diveport.war file

For example:

/di/platform/webapps/mydiveport/diveport.war

* "Enter DivePort Webdata Directory Here" —The path to the
webdata directory (dataroot)

For example:

/di/platform/webdata/mydiveport

* "Enter DivePort WebApp Directory Here" — The path to the
webapps directory (approot)

For example:

/di/platform/webapps/mydiveport

* "Enter DiveLine Server String Here" —The Diveline server
name

For example:

ubuntu:2131

e "Enter Admin Username Here" — The DivelLine administrator
name, which is defined in Creating an Administrator and a Test User
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on page 35.
For example:

admin

e To suppress the <diveport name> in the URL, add the node-
idparameter with a value of servername (/).

For example:

<Parameter name="node-id" value="ubuntu:2131" />

5. Remove uncomment this and set the following parameters: and
the surrounding comment markers (<!-- and -->).

For example:

<Context
docBase
="/di/platform/webapps/mydiveport/diveport.war"
unpackWAR="false" sessionCookiePathUsesTrailingSlash="false" >
<Parameter name="dataroot" value="/di/platform/webdata/mydiveport" />
<Parameter name="approot" value="/di/platform/webapps/mydiveport" />
<Parameter name="diveline.server" value="ubuntu:2131" PR 39377/>
<Parameter name="diveline.admin-username" value="admin" />
<Parameter name="node-id" value="ubuntu:2131" />
(Optional) for single-sign-on with a CGI-mode installation,
set these parameters:
<Parameter name="diveline.web-auth-start-url" value="Enter DLCGI DivePort
URL Here"/>

<Parameter name="diveline.web-auth-finish-url" value="Enter Logoff URL
Here"/>

(Optional) If you need to permit HTTP connections:
<Parameter name="require-confidentiality" value="false" />
</Context>

IMPORTANT: If you do not require HTTP connections, comment out the
require-confidentiality parameter. If you permit HTTP connections,
you are allowing unsecured communications with DiveLine.

6. Save your changes and close the file.
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NetDiver

Installing NetDiver

NetDiver is the web-based analytics client of the Diver Platform. NetDiver
provides ad hoc reporting and analytics tools in a web browser.

Prerequisite: Install Apache Tomcat and Diveline before you install NetDiver.

To install NetDiver:

1.
2.

If running, stop the Tomcat web server.
Navigate to the /di/platformdirectory
cd /di/platform
Unzip the netdiver.zip file.
sudo unzip netdiver.zip
Navigate to the netdiver directory.
cd netdiver
View the unzipped netdiver.zip file.
1lg =1
The unzipped NetDiver package creates the following directories and file
in the netdiver directory:
e /appdir
e /datadir
 context-file-template.xml

Copy the appdir directory to the /di/platform/webapps directory and
rename it to assign a NetDiver portal name (for example, mynetdiver).

sudo cp -r appdir /di/platform/webapps/mynetdiver

Copy the datadir directory to the /di/platform/webdata directory and
rename it to the same NetDiver portal name (for example, mynetdiver).

sudo cp -r datadir /di/platform/webdata/mynetdiver
Navigate to the /di/platform/netdiver directory.
cd /di/platform/netdiver

Create a copy of the context-file-template.xml file and rename it to the
name of your NetDiver portal (for example, mynetdiver.xml).

sudo cp -1 context-file-template.xml mynetdiver.xml
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10. Check the permissions of the mynetdiver.xml file.

ls -1 mynetdiver.xml

The permissions display. If the permissions are -rwxrwxrwx, you can open
and modify the directory and its contents. If you do not have permission:

a. Enable the execute permission.
sudo chmod a+rwx mynetdiver.xml
b. Verify that the permissions have changed.
ls -1 mynetdiver.xml
The permissions display as -rwxrwxrwx.
11. Open the <NetDiver name>.xml file with a text editor, such as gedit.
gedit mynetdiver.xml

The file opens in the text editor.

<Context docBase="Enter NetDiver War File Path Here" unpackWAR="false"
sessionCookiePathUsesTrailingSlash="false">

</Context>

12. Edit the <NetDiver name>.xml file to include the following changes:

* "Enter NetDiver War File Path Here" —The path to the
netdiver.war file

For example:

/di/platform/webapps/mynetdiver/netdiver.war

* "Enter NetDiver WebSite Directory Here" —The path to the
webdata directory (dataroot)

For example:
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/di/platform/webdata/mynetdiver
e "Enter Path to Directory Which Contains NetDiver War
File Here" — The path to the webapps directory (approot)
For example:
/di/platform/webapps/mynetdiver

e "Enter Default DivelLine Server String Here" —The Diveline
server name

For example:
ubuntu:2131

e Change the "diveline.allow-server-change" parameter value to
true

Optionally, you can permit unsecured HTTP connections and export to x/sx
instead of x[s Excel file extensions.

Remove uncomment this and set the following parameters: and
the surrounding comment markers (<!-- and -->).

For example:

<Context

docBase

="/di/platform/webapps/mynetdiver/netdiver.war"

unpackWAR="false" sessionCookiePathUsesTrailingSlash="false" >
<Parameter

name="netdiver.dataroot" value="/di/platform/webdata/mynetdiver" />
<Parameter name="approot" value="/di/platform/webapps/mynetdiver" />
<Parameter name="diveline.server" value="ubuntu:2131" />
<Parameter name="diveline.allow-server-change" value="true" />

<Parameter name="require-confidentiality" value="false" />
</Context>

NOTE: If you do not require HTTP connections, comment out the require-
confidentiality parameter. If you permit HTTP connections, you are
allowing unsecured communications with DivelLine.

Save and close the file.
Navigate to the /di/platform/netdiver directory.
cd /di/platform/netdiver

Copy the <NetDiver name>.xml file to the Tomcat directory.
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sudo cp mynetdiver.xml /etc/tomcat<version-
number>/Catalina/localhost

17. Start Tomcat.

Verifying the NetDiver Installation
Verify that your NetDiver installation is working by entering the NetDiver URL in
a web browser.
Prerequisite: Download, install, and configure NetDiver.
1. Enter your NetDiver URL with the following syntax:

https://<servername or IP address>:8443/<NetDiver name>

For example:
https://ubuntu:8443/mynetdiver

NOTE: If the server name does not work, use the IP address of the
DivelLine server.

NOTE: If you have problems connecting to NetDiver, check your logs and
the configuration changes made to the mynetdiver.xml. The example

URL reflects changes made in the Installing NetDiver topic. Additionally,
if the Linux server is running in a VM, you need to verify that you have
configured the network connection options correctly. Refer to Verifying
the DivePort Installation for additional information.

2. If you have successfully installed NetDiver, the NetDiver start page with a
log in dialog box opens.

NetDiver

wersion 7.0 (56.2)

= %

Username: Password:

| admin | [

Diveline Server:

[ubuntu:2131 ] Log On

2002-2020 Dime:
NetDiver and Ti
Dir

3. If you installed a self-signed certificate and you have not previously
logged in to the Linux server with a DI client, the client might ask you to
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verify the self-signed certificate. Refer to Verifying the DivePort
Installation for additional information.

4. Once connected and logged in to NetDiver, click About to open the

About NetDiver dialog box that lists the current version numbers of
DivelLine and NetDiver.

NetDiver

version 7.0 (56.2)

Diveline 7.0 (56.2)
"

€ 2002-2020 Dimensional Insight, Inc. All rights reserved.
NetDiver and The Diver Solution trademarked by
Dimensional Insight, Inc.

0K

5. Click OK to close the dialog box.

6. Click HELP to open the NetDiver Help system in a new tab in your
browser.
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Installing Diver Platform
Developer

The following installation process requires a computer with Windows installed.
This installation cannot be done on a Linux operating system.

Downloading and Extracting the Developer Installation
Package

This topic describes how to download and extract the Diver Platform Developer
7.1 Windows software package. See Downloading the Server Installation
Package on page 16 for information on how to locate DI installation files.

NOTE: Install Diver Platform Developer on your local computer, not the server.

See About the DI Directory Structure on page 10 to prepare the client
computers.

Complete the following steps:

1. On the software and documents download page on DI-Download, locate
the latest version of the Diver Platform Developer 7.1 Windows installation
package, and click the version number.

Diver Platform Asian Language Pack 7.0 Windows Unicode 7.0.53 (130770KB) Previous Point Releases Mot Available Not Available

Diver Platform Developer Pack 7.1 Windows Unicode limited 7.1.12 (387838KB) Previous Point Releases Mot Available Not Available
Diver Platform Developer Pack 7.1 Windows 7.1.12 (387820KB) Previous Point Releases Mot Available Not Available

Diver Platform Developer Pack 7.1 Windows limited Update not available None Available Mot Available Not Available

Diver Platform Developer Pack 7.0 Windows Unicede limited 7.0.53 (423764KB) Previous Point Releases Release Notes (2402KB)  Manual (8409KB)

v

Diver Platform Developer Pack 7.0 Windows 7.0.53 (423746KB) Previous Point Releases Release Motes (2402KB)  Manual (8409KB)

The Opening download verification dialog box opens.

Installing Diver Platform Developer
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Opening diver-platform-devpak-7.1.12.2-winx64.zip x

You have chosen to open:
diver-platform-devpak-7.1.12.2 -winx64.zip

which is: Compressed (zipped) Folder
from: https://www.dimins.com

‘What should Firefox do with this file?
@Qpen with | Windeows Explorer (default) ~
() Save File

[ Do this automatically for files like this from now on.

Cancel

The Downloading page opens in the browser. If the Opening dialog does
not open automatically, follow the instructions on the page.

Downloading: Diver Platform D

loper Pack 7.1.12 Wind

If the download fails, click here.
Please tell us what you were trying to download and which web browser you were using (including version).

To return to your downloads list, click your browser's ‘Back’ button.

2. Select Save File and then click OK.

Opening diver-platform-devpak-7.1.12.2-winx64.zip *

Yeu have chosen to cpen:
diver-platform-devpak-7.1.12.2 -winx64.zip

which is: Compressed (zipped) Folder
from: https://www.dimins.com

‘What should Firefox do with this file?

(O Openwith | Windows Explorer (default) ~

[[] Do this automatically for files like this from now on.

Cancel

The Diver Platform Developer 7.1 software package is saved to the
Downloads directory on your local computer.

3. Move the developer package to the bI1\Solution\downloads directory.

4. Right-click the package and select Extract All, or use a third-party tool, to
unzip the file.

Installing Diver Platform Developer
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The following executable files are extracted to the directory:

ﬁ di-broadcast.exe

ﬁ di-config.exe

5 di-odbe.msi

l’_& di-scheduler.exe

| diver-platform-devpak-7.1.12.2-winx64.zip

(& HelpDesk-Setup.exe
(@ ProDiver-Setup.exe
(& Workbench-Setup.exe

Installing ProDiver

ProDiver is the desktop analytics client of the Diver Solution and Platform. With
ProDiver, you can view and analyze model and cBase data with a graphical user
interface. You can create markers in ProDiver and use those markers to build
dashboards and presentations in DivePort.

NOTE: You need to be an administrative user to install the software.

The ProDiver installer places a copy of the Setup Wizard in the Program Files
directory for uninstalling purposes.

To install ProDiver:
1. Navigate to the DI\Solution\downloads directory.
2. Double-click the ProDiver-Setup.exe file.

The User Account Control dialog box opens, asking you to confirm
making changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable file.

3. Click Yes.
The ProDiver <version number> Setup Wizard dialog box opens.

Installing Diver Platform Developer
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(3 ProDiver 7.1 (12.2) Setup - x

Welcome to the ProDiver 7.1 (12.2)
Setup Wizard

This wizard will guide you through the installation of ProDiver
7.1(12.2).

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.,

Click Mext to continue,

4. Review the setup instructions, and click Next.

The Installed ProDivers page displays.

(it ProDiver 7.1 (12.2) Setup — X

1 1 Installed ProDivers
Paﬂe]?qéoﬂa-]r List of currently installed ProDivers

Current ProDiver installations (dlick for details):

Upgrade

Uninstall

(®) Install New

< Back Cancel

5. Select the Install New option.
This page lists any existing ProDiver installations, which you can choose to
Upgrade or Uninstall. If this is the first installation, Install New is selected
by default.

6. Click Next.

Installing Diver Platform Developer
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The ProDiver Install Path page displays the default installation path. For

example, C:\Program Files (x86)\Dimensional Insight\ProDiver.
Make changes if necessary.

(71 ProDiver 7.1 (12.2) Setup

Dimensional PreDiver Install Path
| NS ITGHT

ProDiver Install Directory:

| C:\Program Files (x88&)\Dimensional Insight\ProDiver

Mullsoft Install System w2, 46

7. Click Next.

The Ready to Install page displays a summary of the pending installation.

(37 ProDiver 7.1 (12.2) Setup

. : Ready to Install
Pan‘ée]?séoﬂall Summary of the pending installation

Flease review the information below. When you are ready, press "Install”.

Date: 2020-04-23
Installation:
Product: ProDiver
Version: 7.1 (12.2)
Install location: C:\Program Files (x85)\Dimensional Insight\ProDiver

Mullsaft Install Swstem w2, 46

8. Click Install to install the ProDiver software.

When complete, the wizard displays the Installation Complete dialog
box.
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(51 ProDiver 7.1 (12.2) Setup -

b 1 Installation Complete
P:ln‘éer?qéorl}all Setup was completed successfully.

Completed

Show details

Mullsaft Install Swstem w2, 46

< Back Cancel

NOTE: To view a running summary of the installation process, click the
Show details button.

9. Click Finish to close the installation wizard.

NOTE: When you run the ProDiver installer for a new installation or an
upgrade, it associates dlk files with the ProDiver executable file for
opening ProDiver from DivePort.

ProDiver Installation Silent Option

The ProDiver installer has a "silent option" that administrators can use to run the
installer remotely on multiple workstations without interaction from the user.

To run the installer in silent mode, use the /s option (with case sensitive,
uppercase "/s") in the command line of the end user's computer. For example:

ProDiver—-Setup.exe /S
The following options can be used for more control.

Installing Diver Platform Developer
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Option Description

/mode= Indicates the action for the installer. Values are:

e install
e upgrade
e uninstall

e list

If there are no existing installations, the installer defaults to
doing a new install. If there is one existing installation, the
installer defaults to doing an upgrade. If there are multiple
installations, there is no default mode—to perform an
upgrade or uninstall, you must specify the installation. Use
the list option to see existing installations.

/path= Indicates the target location. The default value for the path
is:

"C:\DI\Solution\executables\prodiver"
The installer writes a log file called installation.log to the

user-specified or default path with information about the
installation.

On computers with multiple installations, indicates which
installation to upgrade or uninstall. The format used is that
of the GUI installer (for example "ProDiver-2019-02-26-17-

41-29").
\ J

/installation=

NOTE: When output is sent to the console to display a list of errors encountered
when running, you might be prompted to press Enter to continue. If the
message does not indicate that the installer has completed, the process might
still be running in the background. If you need to perform other tasks, use a
separate command window.

Examples:

A new installation to the default path on a computer with no existing ProDiver:

ProDiver-Setup.exe /S
That installation can be upgraded using the same command line:

ProDiver-Setup.exe /S
A new installation to a non-standard path:

ProDiver-Setup.exe /S /path=c:\di\solution71l\executables\prodiver71l
If it is the only ProDiver on that computer, you can upgrade by using:

Installing Diver Platform Developer
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ProDiver-Setup.exe /S
If you want to be sure that you are doing a new installation or an upgrade,
specify the mode explicitly:

ProDiver-Setup.exe /S /mode=install
ProDiver—-Setup.exe /S /mode=upgrade

To see a list of installed versions:
ProDiver—-Setup.exe /S /mode=list
An upgrade to a particular version:

ProDiver—-Setup.exe /S /mode=upgrade /installation=ProDiver-2019-
0804-12-58-26

Verifying the ProDiver Installation
To verify a successful implementation of ProDiver, complete the following steps:

1. Open the Windows Start menu and enter ProDiver in the Windows
search box.

2. In the Programs list, click ProDiver.

The DI-DivelLine hostname dialog box opens.

Dl-Diveline hosthamme?

ok | Cahicel |

NOTE: If you used ProDiver to check the DiveLine installation, this is not
the initial use of ProDiver. The DiveLine Login dialog box opens directly.

Skip to Step 6.

3. If you are using the default port number 2130, enter <server>. If you are
using another port number, enter <server>:<port number>. For
example, jsmith-001:2131.

If the connection fails, the Select DiveLine Server dialog box opens. If
successful, skip to Step 6.

4. Enter or select the name of the server and click Select.

Installing Diver Platform Developer
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L‘_ Select Diveline Server... e
Server jsmith-001:2131 j
[~ Use IPvG

Select | Exit |

NOTE: The default port number is 2130. If you are using another port,

specify it in the Server box by using the format <server name>:<port
number>.

The Verify Certificate window opens.

Verify Certificate

The server requires encryption, but presented an unknown
certificate. Please verify the following and indicate whether or not
you trust this certificate. If you do, you will not be asked again.

Certificate Owner: Details » = |
Jsmith-001

Dimensional Insight
Burlington, MA US

Accept | Decline |

5. Review the certificate, and click Accept.

The Diveline Login dialog box opens.

BN Diveline Login... *

Server jsmith-001:2131

Connection encrypted

Username ||

Password I

oK | Cancell

6. On the DivelLine Login dialog box, enter the Username and Password
and click OK.
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BN Diveline Login... X
Server jsmith-001:2131
Connection encrypted
Username I admin
Password Im
Cancel |

TIP: If you want to use a different server, click Cancel, and return to Step
4.

7. Select File > Open, or click the Open icon, -3
The Open File dialog box displays sample model and DiveBook files.

NOTE: Your display might contain different files.

n Open File

Look in: ID i

demo-divebook dbk
& demo-sales.mdl
demo_drs.dbk

& demo_drs.mdl

Lo
R
b
i

File name: I

Files of type: IProDiver Files ( mdl. dvp; mrk;.dbk:ref.tnl;.quvs)

=]
cans |

8. Select a dbk file, and click Open. For example, demo-divebook.dbk.

9. Select an Area and a Topic, for example Tabulars and Sales Region, and
click OK.
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DiveBook Select X

Dimensional Insight

Areas Topics

Southern Salespeople

Reports Business Type

Charts

Ad Hoc Analysis Month/Product MultiTab
Web Links Region/Month CrossTab
~Topic Info

If you see a tabular display similar to the following, ProDiver is functioning

W ProDiver - m] x
File Edit Dats Display Organize Window Help
- N - - = . . N |
m-E-8-FE-BR-heannT
Console
Q [=] sales Region [demo-sales.mdl-Dive A] = R
-9 H\stury(demuisales‘mdl] sales Region | Plan Units Plan Dollars Actual Actual
+-[ Sales Region Total Total Units Total Dollars Total
o
=% :ﬂ‘“dﬂ‘ﬁ Totals 2,082 8:630,600 2526 9,624,200
=% demo-sales.mdl Far West 247 1,031,100 336 1,320,700
Industry Code Mid Atlantic 206 1,342,300 403 1,680,200
ﬁ“""e”Tﬁ’e Mid West 222 850,200 260 779,600
ompan ame N
pany | Mountain West 257 1,061,300 304 1,175,200
Sales Region —_—
) Northeast 320 1,361,100 347 1,513,600
Customer Location 1
South 452 2,012,600 507 1,892,600
Sales Branch T
salesperson Southwest 2718 972,000 369 1,262,300
Month
Product
=@ Info
Dive A |D\'vaE |Divec Dive D
[ |7 Rows (Totals-7) Logged in as zdmin (smith-001:213T) /|

10. To view the installed version of ProDiver and the DivelLine server name
and version, select Help > About ProDiver.
Confirm the versions and click OK.
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About DI-ProDiver... X
| Dimensional Insight, Inc.
E:!;" DI-ProDiver 7.1 (12.2)

Copyright 1991-2020 Dimensional Insight, Inc.

Server jsmith-001:2131
7.1 (12.2)
Connection encrypted with S5L (AES256-GCM-SHA3E4)

11. To open ProDiver Help select Help > View Help.
ProDiver Help opens in your default browser.

Dinlellsional ProDiver Help  Getting Started ~ Presentation ~ Managing Data
I'NSITGHT

Search ProDiver 7.1 Help

ProDiver Help
Using Help Overview 7.1 Features
Finding information About ProDiver New ProDiver features

(?) N =

Tables Graphs Reports
Organize data in a tabular Visualize data Present and share data
format
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Installing Workbench

Workbench is an integrated development environment (IDE), designed to
simplify and speed up development of applications to model your data. With
Workbench on your desktop, you can manage projects on the server, and test
and visually examine your data flows and processes. In addition, Workbench
provides one point of entry for all your Diver data servers, consolidating the
tasks of developing, testing, and managing multiple data projects.

NOTE: You need to be an administrative user to install the software.
Complete the following steps:

1. Navigate to the DI\Solution\downloads directory.

2. Double-click the Workbench-Setup.exe file.

The User Account Control dialog box opens, asking you to confirm
making changes to your device.

NOTE: Depending on your Windows version and user account settings,
you might see the Open File - Security Warning dialog box instead.
Confirm that you want to open and run the executable file.

3. Click Yes.

The Workbench <version number> Setup Wizard dialog box opens.

() Workbench 7.1 (12.2) Setup — *

Welcome to the Workbench 7.1
(12.2) Setup Wizard

This wizard will guide you through the installation of
Workbench 7.1{12.2).

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Mext to continue,

4. Review the setup instructions and click Next.

The Installed Workbenches page opens.
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(7 Workbench 7.1 (12.2) Setup — X

1 3 Installed Workbenches
Pan‘ée]?séoﬂall List of currently installed Workbenches

Current Workbench installations (dick for details):

Upgrade

Uninstall

(®) Install New

Mullsaft Install Swstem w246

5. Select the Install New option. This page lists any existing Workbench
installations, which you can choose to Upgrade or Uninstall. If this is the
first installation, Install New is selected by default.

6. Click Next.
The Workbench Install Path page opens and displays the default

installation path. For example, C:\Program Files (x86)\Dimensional
Insight\Workbench. Make changes if necessary.

(71 Workbench 7.1 (12.2) Setup — e

Dimensional  Werkbench install Path
I NSITGHT

Install Directory:
| C:\Program Files (x86&)\Dimensional Insight\Workbench

Mullsoft Install System w2, 46

7. Click Next.
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The Ready to Install page opens and displays a summary of the pending
installation.

ﬁ} Workbench 7.1 (12.2) Setup — P4

. : Ready to Install
Pan‘ée]?séoﬂall Summary of the pending installation

Flease review the information below. When you are ready, press "Install”.

Date: 2020-04-23
Installation:
Product: Workbench
Version: 7.1 (12.2)
Install location: C:\Program Files {(x86)\Dimensional Insight\Workbench

Mullsaft Install Swstem w2, 46

8. Click Install to install the Workbench software. When complete, the wizard
displays the Installation Complete page.

(37 Workbench 7.1 (12.2) Setup —

- 3 Installation Complete
Pange]?séotl}all Setup was completed successfully.

Completed

Show details

Mullsaft Install System w2, 46

< Back Cancel

NOTE: To view a running summary of the installation process, click the
Show details button.

9. Click Finish to close the wizard.
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NOTE: The Workbench installer, starting with version 7.1(12), enables TLS 1.2 on
Windows 7 if it was not explicitly disabled by the user.

Verifying the Workbench Installation
To verify a successful installation of Workbench, complete the following steps:
1. Open the Windows Start menu and enter Workbench in the Windows
search box.
2. In the Programs list, click Workbench.
NOTE: When you open Workbench for the first time, it prompts you to
select a directory for storing configuration files when you work offline. The

defaultis the c:\DI\Solution\dl-dataroot directory for the local
Diveline installation.

a. Click the Browse button to select a different Workbench
configuration directory.

b. Click Finish.

Configure Workbench - O x
Configuring Local Machine
Select your configuration directory

To work offline, Workbench needs to know where to put the
configuration files.

ou can reuse the dataroot of a local Diveline installation. or put it
somewhere else.

Configuration directory:

[C:\DI\Solution'd -detaroot |

DiveLine ‘ Dataroot |

Diveline-2131

< Back Finish Cancel

3. If successfully installed, the Workbench Start page opens.
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222 Warkbench - m} X
File Edit View Tools Help

B-Bld e~ C 2 | -2
g

e Show | Schedules . || Showonlyfailed schedules [ | Displayorphaned schedules

Q @ @ Default Connections
Recent Connections
Recent Connections ]

Connect to server

Work Offline

Recent Projects

Select a connection to work on a project

Errors Running (0) Finished jobs Cutput Find Resulis Messages

4. To view the Workbench version number, click Help > About Workbench.
Confirm the version, and click OK.

About Workkench

Workbench

Client Version 7.1 (12.2)

Copyright & Dimensional Insight, Inc. 2010-2018
Dimensional Insight, Inc.

Server Versions:
Unconnected

Some icons by Yusuke Kamiyamane. All rights reserved.

5. To open Workbench Help in a browser window, click Help > View Help or
click the Question mark icon.
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Workbench Help Basics Tools  Add-ons

Workbench Help

Using Help Overview 7.1 Features
Navigation tips About Workbench New Workbench Features
9 & Hew
Server Settings Spectre Production
Configurations Overview Overview

S IO

The Workbench Help opens in your default browser. Here you can find
topics that explain how to connect to a server.
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